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Getting Started 

The procedures presented herein assume that the purchaser of this product has basic computer skills 

and has used the Windows environment in the past. Many of the functions such as file open, file save, 

run option and the like can change depending on the operating environment the application is executed 

in. In such cases please refer to the user’s manual for that environment (supplied by that vendor). 

Administrator Rights 
Throughout the documentation we talk about logging into the system as a user with Admin or 

Administrator rights. In PM Coordinator, and the lack of user accounts, all users have Administrator 

rights. 

Installing the Application  
PM Coordinator can be supplied to you a few different ways. We can send you a compact disk (CD), 

DVD, and the software can be downloaded. 

IMPORTAND NOTE: If you already have a demo of the software installed, re-

installation may not be required. Just activate the demo. 

To install PM Coordinator onto your computer: 

FROM DOWNLOAD 

• Create a directory or folder on your local hard drive to download the file to. 

• From the web-site, click on the appropriate download link to begin the download. 

• Save the file to the directory you created above. 

• Run the downloaded application to start the installation process. 

• Follow on screen instructions. 

FROM CD OR DVD 

• Insert the CD or DVD into an available reader. If your computer is setup correctly, the program 

should run automatically. 

• If the program doesn’t start automatically: 

o Click the Start menu and choose the Run option. 

o Click the Browse button and navigate to your media reader. 

o Select the Setup.exe application on the root directory of the CD/DVD. 

o Click Open. 

o Click OK. 

• Click the Install Products option. 

• Click on the option that best describes the application you want to install. 
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• Follow on screen instructions. 

Installing for Network Use 
Please note that a Network/Site License must have been purchased to use the routines outlined in this 

section. If such a license has not been purchased then your databases must reside on the local C: drive. 

To install the program for use on a network, please follow these steps: 

• Install the program on each client computer as you would as if it was a single user setup 

(previous section).  

• Activate the software on each computer it's installed to. If not activated, network paths will not 

be allowed. 

• Copy the databases used by the program to a sharable network drive. These are the files with an 

.mdf file extension. 

• Also copy the database’s associated transaction log file. This file will have an extension of .ldf, 

and shares most of the same name as the database file it’s associated with. 

• Set up the database connections to use the copied databases.  

Setting up Database Connections 
By default, the databases used by the PM Coordinator system are installed to the C:\PM Coordinator 

NET folder. It is highly recommended that you leave a set of these databases in this location. However, 

there are occasions when you want them to reside in other locations, such as on a network drive or 

share. When moving the databases, we recommend copying the databases to the new location. 

Please note that a Network/Site License must have been purchased to network 

the databases. 

To setup your database connections: 

• Log in to the program as a user with administrator rights. 

• From the main start menu, open the Admin drop down menu and select the Databases option. 

• Now select the Setup Database Connections option. 
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• From the invoked Settings dialog, move to the Main Database group and click on the Set 

Connection button.  
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• This will invoke the SQL Connection dialog screen as shown in the following illustration: 

 

• Move to the Sever name drop down box and select the name of your instance of the SQL server 
you’re using. If the server is not listed, try clicking on the Refresh button. 

• Move to the Log on to the server group and setup your log on authentication information.  
o Using SQL Express - If you are using the Express database engines as supplied by us, 

you’ll probability want to check the Use Windows Authentication option.  
o SQL Server - If you are connecting to full blown SQL Server then complete the SQL 

Server Authentication information. 
▪ Check the Use SQL Server Authentication option. 

• Fill in the User Name and Password fields. 

• Next move to the Connect to a database group to connect to the actual database. 
o SQL Server: 

▪ Check the Select or enter a database name option. 
▪ Move to the drop down found here and either select or enter the name of the 

database you are connecting to. 
o SQL Express: (Attached database file) 

▪ Check the Attach a database file option. 
▪ Either use the Browse button here to select the database file, or type in the full 

path to the database (mdf) file in the space provided. 

• Test Connection – Move to and click on the Test Connection button to ensure you have a good 
connect. If it fails, you may want to click on the Advanced button to further define you 
connection properties. 

• Click on the OK button. 

• Repeat the above steps for the remaining databases that require setup. 
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Using Multiple Database Configurations  

Saving and Opening Database Settings 
You can create different database setups to be used at different times. For example, if you use a laptop 

you could have a setup saved for use at home and one for work. 

 

To save the current setup 

 

• Setup all the connections for all the databases as you would like to save. 

• Open the File menu and select the Save Custom Setup option. 

• Use this Save As dialog as normally found in Windows. Make the file name something like 

Home, Office or Work, and click the Save button. 

To open a saved setup 

 

• Move to the Connection Settings dialog. 

• Open the File menu and select the Open Custom Setup option. 

• Use the invoked File Open dialog as you would any File Open dialog found in Windows, locating 

the setup file you wish to open. 

• Click on the Open button. 

Opening Different Databases Connections at Startup 
Once you have saved various database connection setups, you can open one of these setups from the 

main menu of the application. This feature can come in handy for a variety of reasons. A couple of good 

examples are when you have database setups for either different clients, or different plant locations. 

To open a saved database setup: 
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• Start PM Coordinator in your normal manner. 

• Open the File drop down menu from the main menu of the program, and then choose the Open 

a database Setup option. 

• Use this file open dialog to select one of your saved setups. 

• Click open and the program will restart with the new setting applied. 

Brief Description of the Databases 
• Main Database - This database holds the main information or tables dealing with PM 

Coordinator. Some of the included tables are HR (Employees), Inventory and Parts, Contacts and 

Vendors, Maintenance Documents, Main Programs settings and User Accounts. 

• Work Orders Database – This database hold everything dealing with work orders and PMs. This 

also includes work instructions and time tracking information. 

Running the Program 
Once the program has been successfully installed onto your computer, you can now begin using it by 

following the next instructions: 

• Click the Start button for Windows XP or later. 

• Click SST then the PM Coordinator option to start the program. 

OR 

• Click the PM Coordinator icon on your desktop. 

Activating or Validating the Software 
The primary way the software is validated or activated is through email, the general procedure for this is 

as outlined next: 

To activate the application from an email message (Outlook example): 

1. Open the Email in Microsoft Outlook. 

2. Open the File menu and select the Save Attachments option. 

3. The Save Attachment dialog opens. 

4. Browse to the following directory: 

     Documents/PM Coordinator 

5. Click on the Save button, replacing any existing files. 

6. Run the program and it should turn into a full working version. 

 

Validating from Demo Mode  
To unlock a demo version into a full working version please follow these steps: 
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• The application must first be purchased and an activation file supplied by Simplicity Software 

Technologies Inc. The name of the activation file is: MC_Act.lic. 

• Run the application in your normal manner. 

 
• From the Running In Demo Mode screen, move to and click the Activate Software button. 

• From this common Open file type dialog, browse to where you saved the activation file as 

supplied from Simplicity Software Technologies. The file name should be: MC_Act.lic 

• Select the file and click Open. 

• The program should now be a full working version.  

Validating from within the Application  
To activate the software from within the application, please follow these steps: 

Note this procedure can also upgrade the application with newly purchased 

features. 

The application must first be purchased and an activation file supplied by Simplicity Software 

Technologies Inc. The name of the activation file is: MC_Act.lic. 

• Run the application in your normal manner. 

 
• Open the File menu and expand the Software Activation sub menu. 

• Click on Install License Activation File option. 
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• From the common Open file type dialog, browse to where you saved the activation file as 

supplied from Simplicity Software Technologies. The file name should be: MC_Act.lic 

• Select the file and click Open. 

• Restart PM Coordinator. 

• The program should now be a full working version.  

Activation Files 
Please note that this activation file can be distributed to you through email or on other computer media. 

This file must be kept in a safe location and will be needed to activate the software on any computer or 

terminal it will be installed on. Feel free to make a single copy of this activation file for safeguarding.  

Be aware that sharing the Activation file with persons or organizations other that 

who it licensed to is strictly prohibited, and is in violation of federal and 

international copyright laws. Both parties could be prosecuted. 

IMPORTANT NOTE – Please note that validating the software is only part of the activating procedure. 

This step will only unlock a demo for a period of at least 45 days. In order to continue to use the 

software a Software Key must also be entered. Also note that the software will function without any 

limitations whatsoever within this 45 day period. 

Entering a Software Key 
Once the inspection period (30 day return policy)has expired and full payment has been secured by 

Simplicity Software Technologies Inc. you will be supplied a software key. Once the software key has 

been supplied we recommend that you enter it immediately. If not entered within 45 days of the 

activation date, the software will lock you out. 

Also note that we normally use first class mail to deliver these software keys to you, so please be on the 

lookout for this letter. 

To enter your software key: 

• Run the application in your normal manner. 

 
• Open the File menu and expand the Software Activation sub menu. 
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• Click on Enter Software Key option. 

 
• Enter the key in the space provided and click OK. 

Why Software Keys 
Software keys are our way of extending credit to our customers. When the software is waiting for a 

software key to be issued, it operates without limitation for a period of not less than 45 days. Most, if 

not all our software offerings carry a 30-days money back guarantee, and also have a net due with the 

same time period. Software keys allow us to honor both of these conditions. 

INPORTANT NOTE: As with validating the software, the software key must also be used for each 

installation. Please keep the software key information and the activation file in a safe place. 

Moving Between Modules 
The Maintenance Coordinator program is arranged in modules, with each module providing its own 

functions and features. The modules are accessed mainly through the use of the program’s Main Menu 

screen. 
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To navigate between program modules: 

Option One 

• Move to the main menu and click on a button that best describes the module you want to 

access. 

 

Option Two – Using the Navigation Bar 
The navigation bar is located on the left side of the screen, and can be used to 

navigate through the components of this program. 

• Click on a group within the Main Navigation Bar to expand the group 

and expose its contents. The groups are the larger of the available items shown, 

with larger text and icons. 

• Once a group is expanded, you can click on one of the available options 

to branch to that component or feature. 

• Also note that clicking on a Main Group will normally open that module. 

The main expection to this rule is the Maintenance Documents option. 

Main Program Settings 
The Program Setting allows you setup general features that will be pretty much global to the 

application. Many of the individual modules in the system can also have other settings that pertain to 

that module only and in many cases maybe local the activate computer only. 
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To configure the program settings: 

• Login to program with Administrator rights. 

• Move to the Main Menu screen of the program. 

• Open the Admin drop down menu and select the Main Program Settings option. 

Company Information and Logo 
The information found on this tab can be used on various documents generated by the application. 

 

To setup your company information and logo: 

• Move to the Company Information tab. 

• Move through the various fields of this tab, and enter the appropriate information for each of 

the fields.  The following explains the fields on this tab: 

o Company Name – This alpha/numeric field can contain up to 50 characters and is used 

to maintain your company’s name. 

o Address – These two alpha/numeric fields can contain 50 characters each. Use these 

fields to record street and PO Box information. 

o City - This alpha/numeric field can contain up to 50 characters and is used to maintain 

the city your company is located in. 

o State or Region - This alpha/numeric field can contain up to 50 characters and is used to 

maintain the state or region your company is located in. 

o Postal Code - This alpha/numeric field can contain up to 12 characters and is used to 

maintain your postal or zip code. 
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o Telephone No - This alpha/numeric field can contain up to 20 characters and is used to 

maintain your telephone number. 

o Fax No - This alpha/numeric field can contain up to 20 characters and is used to 

maintain your fax number. 

o Web-Site – There is no size limitation to this alpha/numeric field and is used to store 

company’s web site or URL. 

o Company Logo – This image should measure approximately 1 inch by 1 inch, and 

supports the following formats: bmp, gif, jpg, ico, png and tif. 

Getting Instant Help 
Most, if not all the modules in the system have Help documents associated with them. These are 

accessible from the Help drop down menus, normally located on a module main screen. 

The following illustrates a typical help menu. These are also normally located on the right side of the 

ribbon control. 

 

Pressing F1 from a screen that help is available on, will pull up the main help file associated with the 

module you are currently working with. 

Pressing F2 will allow you browse and open any of the available help documents. 
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Common Use Features 

This section outlines features that are in common use throughout the software system. Some of the 

features explained here may apply to every module in the system, whereas others may only apply to a 

couple of modules. By placing common features together we have reduced the documentation size, and 

hopefully at the same time helped to reduce the learning curve. 

Procedures outline in this, and all other chapters assumes the user has basic computer skills and has 

worked in the Windows environment before. Also note that features such as opening and saving files 

can change by operating systems and because of this will not be discussed here. 

Tool Tips 
Many of the controls on a screen or within a ribbon control have what are known as Tool Tips. What 

these actually are, are little help screens that provide information on what a button or control does. The 

image shown is an example of a tool tip message. 

 

To activate a Tool Tip just place your mouse over a control that supports this feature. If supported, the 

Tool Tip message will be displayed for a few seconds. 

Tile Controls 
Tile Controls are used though-out the application to provide options to the end user. Introduced with 

the release of Microsoft’s Windows 8 OS, these graphical buttons work much in the same way as a 

standard button. We use them with our main menu to allow the user to navigate to the various modules 

of the system. We also use them with our documents to help represent the document types and access 

options. 
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When all the buttons will not fit on a screen, you can click on a non-button area to scroll the control. 

This is done by clicking and holding the left mouse button and then moving the mouse in the direction 

you wish to scroll. 

The keyboard arrow keys can also be used to navigate through the Tile Control buttons. A slight 

highlight around the button will be displayed to show the selection. Once a button is selected, pressing 

the Enter key will activate the selection. 

Using the Ribbon Control 
Throughout the application you’ll find the state-of-the-art Ribbon Control. This is the replacement for 

the conventional menu control that has been used in applications for years. We have based our control 

on the most modern Office styles, which is also part of the Microsoft Office Fluent user interface.  

NOTE: This control as with many of the controls used by this system can have their appearances 

change somewhat by the selected theme in use. 

The following illustration outlines the elements of the basic Ribbon Control: 
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Application Menu (File) 
In the upper left hand corner of ribbon control is the Application or File menu button. Clicking on this 

button opens a drop down that closely resembles the old File menu. Once clicked, the user can then 

click on the various other buttons or options found there.  

 

Please note that in most cases, the Application button is a direct replacement for the File menu. 

Quick Access Toolbar 

 

The Ribbon control has a Quick Access Toolbar associated with it. This toolbar normally contains 

features that are widely used throughout the system. One set controls you’ll find in wide use are the 

data controls that are used to scroll through the records of the database. 

Changing Ribbon Pages 
Controls on a ribbon are grouped in Pages. Pages appear on the ribbon with the same look as a 

conventional tab control. To access controls on different pages simply click on the page header, and 

then click on the appropriate control. 
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Command Region 
The command region of the ribbon control can contain a variety of different other controls. Examples of 

controls that may be placed there are buttons, drop drown list, color and font pickers and others. The 

most common controls found here would be buttons. Clicking a button control normally launches some 

specific function of the application. 

Ribbon – Keyboard Access 
The options available on a ribbon control can be accessed by using your keyboard in place of your 

mouse. This is done with a combination of the ‘Alt’ and some other combination. 

 

To access options of the ribbon control using your keyboard: 

• Press and release the ‘Alt’ key. This action will display the available key combinations that can 

be used. 

• To activate an option press the assigned key or keys as displayed. In the example showing, 

pressing the H key would activate the History Log report option.  

Ribbon – Hot Keys 
Like the traditional program menus, ribbon items can be assigned hot key shortcuts. These are keyboard 

key combinations that access commonly used features. Normally these hot key assignments use the 

‘Ctrl’ key and another key to access a feature. However, other key combinations may also be used. 

Some examples of hot key assignments: Ctrl + N for new, Ctrl + S for save, Ctrl + C to copy text, Ctrl + X 

to cut text, Ctrl + V to paste text, and many others. 

Program Menus 
In various places throughout the application are pull-down or program menus that are located directly 

beneath the screen header or title bars. You'll also notice that these menus will change depending on 

the screen or module that is currently displayed. 
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These menu options allow for easy access of many features and functions the program has to offer to 

the user. 

There are a couple of different methods in which the user can access the contents of pull down menus 

and are outlined next. 

• Press the ALT key along with the highlighted letter to access the pull down menus.  

• Press the highlighted letter to access the options of that menu. 

• Use the arrow keys to highlight the desired menu option and then press ENTER. 

• Put the mouse pointer on the desired option, and then click on the menu option of your choice 

with the left mouse button. 

If the menu option of your choice has a HOT KEY assignment, you can use that to select the menu 

option. Some of the HOT KEYS used by the program are CTRL + X for cutting text, and CTRL + V for 

pasting text. 

Data Controls 
Located in various areas of the program are Data Controls. These controls allow the user to move 

through records in a database and when available add, remove, save, and cancel changes to the 

database. 

 

 

The two images shown are the two data controls used by the application. The first one is normally found 

in the ribbon’s quick access toolbar, and is normally used to function with a module’s main database. 

The second control is normally used with support databases. Attachments database is a good example. 

Not all elements of a data control will be present at all locations it’s used. Factors that can affect an 

element’s existence could be a user’s rights, or whether the functions are needed. 

The following are the elements of the data control, reading left to right. 

• Move First – Moves to the first record in the database. 

• Previous Page – Moves a page of records at a time (not available in the quick access toolbar). 

• Move Previous - Moves to the previous record in the database. 

• Move Next – Moves to the next record in the database. 

• Next Page – Moves a page of records at a time (not available in the quick access toolbar). 

• Move Last – Moves to the last record in the database. 

• Add/Append – Adds a new record to the database. 

• Delete/Remove – Removes the selected record from the database. 

• Post/Save – Post or saves recent changes to the database. 
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• Cancel Edit – Cancels recent changes and restores information. 

Using the Lookup Grids 
Throughout the application you’ll find ‘Lookup Grids’. These are found on the Lookup tabs of the 

majority of the modules, they’re also found on the majority of assignment dialog screens. The picture 

provided is an example of a typical Lookup Grid as found on a Lookup (assignment) dialog screen. 

 

Grouping Items 
You can group items in the Lookup grid by any of the available columns.  Just click and hold the column 

and then drag and drop it into the area just above the columns headings. 
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Once grouped, you can expand or collapse a group by clicking on the appropriate symbol adjacent to the 

group. Also note that you can create a tree type structure with these groups, and you are not limited to 

a single group. 

Filtering Records 
To help facilitate the easy lookup of items, most of the lookup grids employ a Filter row. So if you know 

what you’re looking for you can type in this row to filter out unwanted records and narrow down your 

search. 

 

To filter records 

• Move to the column you want to filter records by and click in the empty row just below the 

column header. 

• Start typing in your filter and watch the grid begins to shrink as you go. Effectively filtering out 

non matching records.  

Resorting the Information 
The majority of the Lookup grids used by the application allow you to resort the information by any 

column of your choosing. 

 

To resort the records 

• Move to and click on the column header. 

• To resort in the other direction, click the header again. 

Moving Columns 
The majority of the Lookup grids allow you to rearrange the columns found on the grids, thereby 

allowing you to customize the grid layout to your liking.  
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To rearrange columns: 

• Just click and hold the column of your choice. 

• Drag the column to its new location and release the mouse button. 

Adding Columns 
The majority of the Lookup grids allow you to add database columns to the grids. This is especially useful 

when we left out a particular column that you just must have. 

 

To add a database column: 

• Right mouse click in the column headers area to pull up a context menu. 

• Click on the Column Chooser option. 

• Double-click on the column or columns you want to add. 

• Click on the Close button in the upper right corner when done. 

Please note that some of the available fields may not display information that the average user will 

understand.  Many of these fields are used internally by the application and are not meant to show data 

directly to the user. 

Removing Columns 
Just as we allow the user to add columns to a grid, you can remove them as well. To remove a column: 

• Right mouse click on the column header that you want to remove. 

• Click on the Remove this Column option 



PM Coordinator 

 

Simplicity Software Technologies Inc. | Using the Lookup Grids 38 

 

Other Options 

There are other options available to the Lookup Grids that the user can explore on their own. To access 

these options just right click within the grid’s header area. 

 

Save Grid Layouts 
Most of the settings we just discussed will reset themselves when the screen is closed and reopened. 

The exception to this rule is found when the Lookup grid is saved by the user. In most cases we made 

this grid savable via the File menu. When a File menu is not available, you may also be able to save the 

grid by right mouse clicking in the rows part of the grid. This will invoke a popup menu. Once your grid is 

customized to your liking, save the grid and the settings so they will be reapplied when reopened. 

The following illustrations shows both of the Main Grid Options as found in the File menu or the Popup 

menu attached to the lookup grid: 

 

Accessing the Main Grid Options (when available) 
To access the Main Grid Options: 

• Move to and click on the ribbon’s File menu. 

• Click on the Main Grid Options button to expand the pop out sub menu. Options on this sub 

menu include: 
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o Print Lookup Grid – This action will invoke a print preview of the main grid. 

o Save Grid Layout – This option saves any customization you may have applied to the 

grid. Once saved, these customizations will be reapplied when the module or lookup 

screen is next shown. 

o Reset Grid Layout – This option will reset the grid back to the settings that was supplied 

by us. You will see the results of this once the module or lookup screen is next shown. 

Accessing the Main Grid Options from the Popup Menu (when available) 
When the File menu is not available, we have provided (in most cases) a popup menu that allows for the 

same options. To access the Main Grid options via the popup menu: 

• Move to the Lookup grid. 

• Right mouse click in the database rows part of the grid. This will invoke the popup menu. 

Options available here mirror those found on the File menu. 

Searching 
The built-in Search Panel provides an easy way of searching against multiple columns. It is 

displayed above the Group Panel. The Search Panel contains a search box and control buttons. 

 

To access the Search Panel, click on the Search button in the ribbon. You can close the panel by 
clicking this button again or clicking the X button from within the panel. When the Search button is 
not available in the ribbon, you can open the Search Panel by first clicking with in the grid and then 
clicking CTRL+F. Clicking ESC - Clears the search box. If the search box is empty, pressing ESC 
closes the Search Panel. 

In its simplest form, search criteria consist of a single word. To search for a string containing a 
space character, specify this string in quotation marks. Without quotation marks, words separated 
by the space character are treated as individual conditions (using the OR logical operator by default 

To search against a specific column, precede a search string with the column's display name plus a 
colon character. 

Precede a condition with "+" to select records that match this condition. Other records will be 
excluded from the result. The "+" specifier allows you to implement the logical AND operator. 

Precede a condition with "-" to exclude records that match this condition from the result set. 

https://documentation.devexpress.com/WPF/CustomDocument6215.aspx
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Examples: 

Search Criteria Description 

register Selects records that contain the "register" string in any search column.  

check register Dave Selects records that contain either "check" or "register" or "Dave" strings in any 
search column. 

"check register" Selects records that contain "check register" in any search column. 

screen +"Richard Fisher" Selects records that contain both "screen" and "Richard Fisher" in search columns. 

data +entry -mark Selects records that contain both "data" and "entry" in search columns, excluding 
records that contain "mark". 

menu mask -file Selects records that contain "menu" or "mask", excluding records that contain "file". 

Note: Searches performed using the Search Panel is case insensitive. 

Tab or Folder Controls 
Tab or Folder Controls are used throughout the application. The main purpose of these tabs is to group 

information and to enable more information to fit on the screen. The following picture displays a typical 

Folder control with 3 tabs. These folder controls are often just referred to as tab controls. 

 

To move from one tab to another simply click on the preferred tab. 

Group Controls 
Group Controls are used throughout the application. Their primary purpose is to tie information 

together into logical groups. This grouping facilitates a better understanding of items by the end user. 

The following illustration show a typical group control along the top. The lower half of the image shows 

a tab control with two tabs. The active or selected tab also contains two more group controls. 
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Selected Group Controls can be opened and collapsed by the user. The controls that you can open and 

collapse have an arrow icon in their upper left hand corners. You just click on these arrows to open and 

collapse these controls. 

Date Controls 
Date Controls are used throughout the application for the purpose of setting or selecting dates.  

 

To display the date control: 

• Click on the Down Arrow along the right side of the control. 

To select a date: 

• Click on the date within the control. 

To move to today’s date: 

• Click on today’s date near the top of the control. 

To scroll through the months: 
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• Click on the forward or back arrows within the control. 

To clear the entered date: 

• Click on the word Clear near the bottom of the control. 

Editing Values, Selecting Text and Using the Clipboard    

Select and Deselect Editor's Contents  
To select all text within an editor, you can invoke the Editor Context Menu and choose Select All. To 

select a part of the edit value, click on a position where the selection should start, drag the pointer to 

the end position and then release the mouse button. 

Additionally, the following keyboard shortcuts allow you to manage selections. 

Shortcut  Description  

CTRL+A or F2  Select all within an editor.  

SHIFT+ARROW  Extends or shrinks the selection by one character.  

CTRL+SHIFT+ARROW  Extends or shrinks the selection by one word.  

 

Clipboard Operations  
Clipboard operations are supported for editors that support caret moving.  

To copy selected text into the clipboard, do the following.  

• Press CTRL+C or CTRL+INSERT.  

• Open the Editor Context Menu and select Copy.  

To paste text from the clipboard, do the following.  

• Press CTRL+V or SHIFT+INSERT.  

• Open the Editor Context Menu and select Paste.  

To cut some text from an editor into the clipboard, do the following.  

• Press CTRL+X or SHIFT+DELETE.  

• Open the Editor Context Menu and select Cut.  

Delete Selected Text  
To delete the selected text within an editor, do one of the following:  

• Press DELETE or BACKSPACE. 
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• Open the Editor Context Menu and select Delete.  

Undo  
To undo the last text editing operation, do one of the following:  

• Press CTRL+Z.  

• Open the Editor Context Menu and select Undo.  

Note: After you've undone an operation, you can return to the previous edit value by executing the 

Undo command once again. 

Change Numeric Values  

 

 To increment a value, press UP ARROW. To decrement the value, press DOWN ARROW. Or, use the 

mouse wheel.  

Edit Images  
To copy, cut, paste, load and save images in image editors, right click the image and select the required 

command via the context menu:  

 

Editor Context Menu   
Text editors support a context menu providing common commands. To open the menu, right-click on an 

editor. 

 



PM Coordinator 

 

Simplicity Software Technologies Inc. | Drop Down List Boxes 44 

 

Drop Down List Boxes 
Used throughput the application are drop down list boxes. The purpose of these controls is to allow the 

user to select an item from a list of choices. 

 

To use a drop down list box: 

• Click on the down arrow on the right side of the control. 

• Use the arrows on the scroll bar to move through the list. 

• Once located, click on the item of your choice to use it. 

Data Quick Entry 
One time saving feature we have installed in most of the data input screens used by the application are 

what we call "Data Quick Entry" routines. These routines are used to store information that you would 

use repeatedly. The idea behind this feature is to allow you to type in commonly used information just 

once. The next time you need it you just call up the routines, select the text from a list, and have it 

automatically inserted for you. 

Each text field in the application that works with these routines has their own filtered databases. For 

example, if you call up the listing while in the "Classification" text field, you'll get a different list of items 

than if you were in the “Project” field. 

Using Data Quick Entry ‘Drop Down’ Lists 
In many cases you access the items of the Quick Data Entry from drop down lists. When used in this way 

these lists are also ‘Auto Complete’ enabled. This is to say that as you type, the program will suggest an 

item that’s already in the list. 

 

You add and delete items in these drop downs by click on the Manage button adjacent to these fields. 
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Calling Up the Data Quick Entry Screen 
To call up the Data Quick Entry list from one of the supported text input fields: 

• Click on the ellipse (…) button, click on the Manage button or click the Select button adjacent to 

the field that you want to make an assignment to. 

 

 

Adding New Quick Entry Items 
Before you can begin using the Quick Entry option, you'll need to add information into the listing. Once 

the list has been populated the information will then be available for insertion. 

To add information to the Quick Entry list, you must: 

• Click on the Add New button. 

• Type in the information you want included in the listing. This text can be any combination of text 

characters and numbers and have a maximum length of 30 characters. 

• Press or click on the OK button to accept the text and add it to the list. 

• Click on the Save Changes button to save your changes. 

Selecting Text for Insertion 
Once you have information installed into the Quick Entry listing, you can use and reuse this text any 

countless number of times. 
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The procedure for selecting text from the Quick Entry list and inserting it into the appropriate field: 

• Click on the ellipse (…) button, click on the Manage button or click the Select button adjacent to 

the field that you want to make an assignment to. 

• Move to the lookup grid and click on the selection of your choice. 

• Click on the Accept button. 

Deleting Item from the Quick Entry List 
If you have information in the Quick Entry list box that you no longer feel is valid; you can delete it by 

following these steps: 

• Click on the ellipse (…) button, click on the Manage button or click the Select button adjacent to 

the field that contains the list you want to edit. 

• Move to the lookup grid and click on the selection of your choice. 

• Click on the Remove button. 

• When prompted if you want to continue, click YES. 

• Click on the Save Changes button to save your changes. 

Data Quick Entry: Drop-Down Lists 

 

Many of the quick entry routines are also have a drop down list box associated with it.  In this case you 

would just select an item from within the list. This list also employs an auto complete feature where the 

program will try to bring up the item you need as you type in the edit area of the drop down. 

If the item you want is not within the list, you can click on the Manage button adjacent to the entry field 

to add the item as described in the previous section.  

Attachments 
Many of the modules within the system use the Attachments Feature. This feature allows you to attach 

items to various records such as work orders, equipment records, employee records and more. 

Basically any type of document or path that can be accessed through the Windows’ Start – Run option 

can be used as an attachment. Normally you just point to a file, and when opened that file will open 

itself within with the appropriate or associated application. These can include, but not limited to 

pictures, CAD drawings, documents, web-sites and more. 

When using pictures, we highly recommend using this feature as opposed to importing them into the 

database. Picture or image files can use a lot of database space in a short amount of time. This could 
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both consume database space and effect database performance. Links to image files on the other hand 

use very little space, and actually provide better support. 

 

The image provided is what the Attachment feature typically looks like. This appearance can change 

somewhat from module to module, but in general it has the same general look and features no matter 

where used. 

To add an attachment 
• Locate and select the record you want to add an attachment to. 

• Move to the Attachment section and click on the plus sign (+) in the data control located in this 

section. 

• From the invoked Attachments dialog, use the Browse button to search and select the file or 

document you want use as an attachment. 

• Once selected, click on the Open button within the Open dialog screen. 

 
• If the default description for this file is not descriptive enough, then move to the Description 

text box in the Description group and edit its contents. 
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• To test if the link actually works, click on the Test/Open button. 

• To accept everything and use the attachment click on the Accept button. 

To open and view an attachment 

• Move to the grid and click on the attachment you want to open. 

• Click on the Open Link button. 

To delete an attachment 
• Move to the grid and click on the attachment you want to delete. 

• Move to the data control and click on the remove (-) button. 

• Click ‘Yes’ to the deletion prompt. 

• Click the ‘End Edit’ or Post button in the data control (check). 

Using Attachments on More Than One Computer 
When using attachments with more than one computer, say with a Network configuration for example, 

we suggest using mapped drives. Using a mapped drive will allow you to create the same path for each 

PC in use. If this is not done the path could change from computer to computer and the attachment will 

not always be found. For more information on mapped drives, search Windows help from My Computer. 

Print Preview  
Just about every module in the system will output some form of a printed document. Sometimes these 

documents can go straight to the default printer, but in almost every case you have the option to 

Preview the documents before actually printing them. The application actually makes use of few 

different preview screens, the most common one of these will be outlined here. 

The following elements are found on the Print Preview ribbon control: 

 

 QUICK ACCESS TOOLBAR 

• The first arrow control moves to the first page of the document. 

• The second arrow control moves to the previous page. 

• The third arrow moves to the next page of the document. 

• The fourth arrow moves directly to the last page of the document. 

• The printer icon prints the document. 
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PRINT PREVIEW TAB 

• Open – Opens a document that was saved to file. 

• Save – Saves the current document to file. 

• Reflow – Redraws the document to screen. 

• Print – Allows you to select the printer to use, and other options prior to printing. 

• Page Setup – Allows you to setup the documents margins, origination and paper types. 

• Zoom In – When clicked, zooms in on the present document. 

• Zoom Out – When clicked, zooms out on the present document. 

• Export Options – Works in the same way as the Save option above. 

• Find – Allows you to search the document for matching text. 

• Previous Page – Moves backwards through the document, one page per click. 

• Next Page – Move forwards through the document, one page per click. 

• Close – Close and exit the Preview Screen. 

Open Document 

To open a save document: 

• Click on the Open option in the ribbon. 

• Use the File Open Dialog as explained by the current operating system. 

• With the file selected, click the Open button. The following file types are supported: c1dx, c1d, 

c1db and c1mdx. 

Save  or Export Document 

To save or export a document 

•  Open the File menu. 

• Click on the Save or Export Options buttons in the ribbon. 

• Use the Save As Dialog as explained by the current operating system. 

• Enter a name for your file in the File Name area and click the Save button. 

The following export formats are supported:  Proprietary formats (c1dx, c1d, c1db, and c1mdx), pdf, 

xlsx, xls, rtf, docx, htm, emf, tiff, png, jpg, gif, bmp and xps. 

Print Document 

To print the document: 

• Click the Printer icon in the quick access toolbar or click on the Print option in the ribbon. 

• From the Print setup the print options to your liking. 

• Click the OK button. 

 Page Setup 

The page setup allows you to setup the paper size, source, orientation and page margins. 
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To setup the current document: 

• Click on the Page Setup button in the ribbon. 

• Setup the options on the Page Setup dialog to your liking. 

• Click on the OK button. 

 

 

Searching the Document 

You can search the document for matching text by: 

• Move to and click on the Find button in the ribbon. This will cause a search dialog to be 

displayed on the right hand side of the Preview screen. 

• Move to the Find What text box, and type in the text to search for. 

• Place a checkmark in the options you want to apply to your search: 

o Match Case 

o Match Whole Word 

o Search Up 

• Click on the Search button.  

To highlight the text that was found, from within the list: 
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• Click on the item found from the displayed list. 

To close the search panel: 

• Click on the Hide button. 

 

 

Spell Checker 
The Spell Checker can be found in the majority of the major editors used by the system. This includes 

such editors as the Rich Text Editor, Text Editor, Tasks Editor and the Email Composer. 

 

When the Spell Checker component finds a word that is not contained in the dictionaries associated 

with the current culture, the Spelling dialog can be used for making corrections. This dialog is invoked 

when a spell check is started on demand (for example, when the end-user clicks a button, or the Check 

Spelling item is selected from the context menu, displayed when the end-user right-clicks the incorrect 

word. 
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Spell Checker Dialog 

 

This dialog enables the end-user to do one of the following: 

• Select one of the suggested corrections to replace the misspelled word (once or all occurrences 

in the text) 

• Skip the word (Ignore) 

• Ignore the word and all its future occurrences in the text. 

• Add the word to a custom dictionary of the Spell Checker (when available).  

The Options... button invokes the Spelling Options Dialog. The Undo button allows cancelling changes, 

step by step. 
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Finding Misspelled Words as you Type 
With some of the editors, misspelled words will be highlighted from within the editor itself. Misspelled 

or unrecognized words will have a wavy red underline below them. When supported, you can right-click 

over these words to invoke a popup menu.  

From this popup you can: 

• Replace the word with one of the supplied suggestions. 

• Ignore All word with the same misspelling. 

• Add the Word to the Dictionary. 

• Or invoke the Spell Check Dialog 

The popup may also show other, non-spell checking related options. 

 

Text Editor 
The Text Editor has been installed throughout the system where the user may need to create or edit 

large amounts of text. 

The following elements are found on the Text Editor tab, reading left to right: 
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• Save and Close – Saves the current text back to the call-up control and closes the editor. 

• Paste – Inserts any clipboard text into the document, and at the current cursor location. 

• Copy – Copies selected text and places it into the clipboard. 

• Cut – Deletes selected text and places it into the clipboard. 

• Select All– Selects all the text in the document. 

• Find – Helps to find matching text. 

• Find Next – Helps to find the next match. 

• Insert Document – Inserts a text document saved to file. 

• Check Spelling – Reviews the document checking for spelling errors. 

• Cancel and Close – Closes  the editor without applying any changes. 

Insert Document 

The Insert Document feature works much like the Open Document feature. However, instead of 

replacing the current document, it inserts it at the current cursor location.   

To insert a text document: 

• Click in the document where you would like the insertion to occur. 

• Click on the Insert Document button in the ribbon. 

• Use the File Open Dialog as explained by the current operating system. 

• With the file selected, click the Open button. 

Open Document 

If wanted, you can create your text documents in other applications such as Windows Notepad, save the 

file as a text file, and then import it here. 

To import a text file, replacing any currently loaded document: 

• Open the File menu. 

• Click the Open Document option. 

• Use the File Open Dialog as explained by the current operating system. 

• With the file selected, click the Open button. 

Save Document 

If wanted you can write text documents using this editor and then save this document to file. 

• Open the File menu.. 

• Click the Save Document option. 

• Use the Save As Dialog as explained by the current operating system. 

• Enter a name for your file in the File Name area and click the Save button. 

Print Preview the Text Document 

To print preview the loaded document: 
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• Open the File menu. 

• Click the Print Preview option. 

Lookup Dialog Screens 
There are many Lookup Dialog screens used by the application that were designed for lookup and 

assignment purposes. As these lookups may represent information from different database tables, we 

have tried to design them so they will function in a similar manner regardless of what information or 

table is being presented. 

Also be aware, that not all the functionality of these lookups will always be available to the user. 

Options can be hidden or disabled by a user’s assigned rights and from where these looks are being 

activated from. 

The following images outline the common elements of most Lookup Dialogs. The provided illustration 

shows the Parts and Inventory lookup dialog, but the same general features are available to the 

Equipment and Assets, Vendor and Contacts, Mechanics and Employees, and other Lookup dialogs 

screens found in the system. 
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Again, we want to emphasize that depending on the rights being assigned at the time, there will be 

many occasions where these Lookup Dialogs will function as ‘Lookup Only’ type dialogs where the 

controls on the Details tab will be disabled or even invisible. At other times you may be allowed to add 

and edit the information without restrictions. 

To select a record for insertion or assignment: 

• From the Lookup Dialog, move to the Lookup tab. 

• To view all currently active records, ensure that the Show Active Only checkbox is checked. To 

view all records uncheck this checkbox. 

• If you know a value of one of the fields, you can move to the Filter Row of the column you want 

to filter by. 

• Typing in the Filter Row will filter the grid with the criteria you typed in. 

• You can also scroll through the records until the one you want is located and selected. 

• Once you find the record you’re looking for, move to and click on the Select button. 

 

To add a new record using the Lookup Dialog: 

• Move to the Data Control and if available click on the plus sign (+) in the control.  

• Move to and click on the Details tab. 

• Move to the various fields on this tab and edit the information found there. 

• Chick on the check (post) button in the data control to save your changes. 
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To edit a record (when available): 

• Move to the Lookup tab. 

• Located and select the record you want to edit from those listed. 

• Move to the various fields on this tab and edit the information found there. 

• Chick on the check (post) button in the data control to save your changes. 

To delete a record (when available): 

• Move to the Lookup tab. 

• Located and select the record you want to delete from those listed. 

• Click in the minus sign (-) button on the data control, 

• Chick on the check (post) button in the data control to save your changes 

Documents Trees 
The Documents Tree is used through-out the system, and its features are duplicated in each place it is 

used. Examples of areas it can be found is in the Documents Features found in many of the modules, the 

Procedures and Solutions module, and the Repair Procedures Editor used with work order instructions.  

Understanding and Using the Documents Tree 

 

The Documents Tree allows for the organization of your documents in Folders or nodes. Basically you 

are not limited to the number of folders you can create and use. You can also create as many levels of 

these folders as maybe needed (parent – child folders). The supplied illustration shows the elements of a 

typical tree control. 

IMPORTANT NOTE: Most of the procedures outlined in this section refer to the use of pop-up menus, 

however many of these procedures can also be duplicated and be found in the ribbon control as well. 

Create a Document Folder 
Each document in the system will be assigned to a folder or tree node in the Documents Tree. Once a 

folder is created documents can be added to it. 
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To create a new Document “Root” or “Top Level” folder: 

 

• Right mouse clicking within a Documents Tree section will invoke a popup menu. 

• Click on the Add Top Folder option. 

• From the invoked dialog enter the name you want to use for this folder and click OK. 

To create a new “Sub Folder” or “Child Node” 
• Move to the Documents Tree and click and select the folder that you want to add a new sub 

folder to. 

• Right mouse click within the Documents Tree section to invoke a popup menu. 

• Click on the Add Sub Folder option. 

• From the invoked dialog enter the name you want to use for this folder and click OK. 

To Remove a Folder 
• Move to the Documents Tree and click on the folder you want to remove. 

• Ensure there are no child folders or documents assigned to this folder. If there are items then 

either move and reassign these items or delete them. You cannot remove a folder if anything is 

assigned to it. 

• Right mouse click on the folder you want to remove to invoke a popup menu. 

• Click on the Remove Folder option. 

To Rename a Folder 

• Move to the Documents Tree and click on the folder you want to rename. 

• Right mouse click on the folder you want to remove to invoke a popup menu. 

• Click on the Rename Folder option. 

• From the invoked dialog edit the folder name to the way you want it and then click OK. 

To move a Folder to the Top Level or Root position 

• Move to the Documents Tree and click on the folder you want to move. 

• Right mouse click on the folder you want to move to invoke a popup menu. 
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• Click on the Move Folder to Root (Top Level) option. 

To move a Folder and Reassign its position in the tree 

• Move to the Documents Tree and click on the folder you want to move. 

• Left mouse click and hold on the folder you want to move. 

• Drag the folder over the folder you want to move it to. 

• Release the mouse button to drop the folder in to its new location. 
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Maintenance Documents 

Any maintenance operation is sure to accumulate a wide variety of documents. Examples of these 

documents could be warranty information, information about your equipment, notes about your 

mechanics, MSDS and the list goes on and on. These documents can also be proven to be very important 

to the day-to-day operation of your maintenance department. For these reasons we have included the 

Documents Database feature. 

 

The Documents Database is included in many of our modules where we felt it would be useful. You can 

find this feature in the Maintenance Scheduler, Equipment module, Purchasing module, Contacts 

module, and HR module. The HR module differs from the others as it’s attached to each individual 

record. This allows you to maintain various documents on a single employee.  

You can create three different types of documents with this feature. One is a picture document, which 

can be in the GIF, JPG, BMP, PNG, TIF and ICO formats. The next type of documents can be the rich-text 

editor type. These editor type documents features the use of our built-in Rich Text Editor. This editor 

supports many professional features such as multiple fonts, colors, paragraph formatting, the use of 

tables and more. Documents created in our Rich Text Editor are compatible with almost all windows 

based word processors such as Word and Word Perfect or any that support the RTF format. 
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The third type of available documents is the Attachments type of documents. Attachments point to 

other files store on hard drives, or other locations such as web-sites or folders. We recommend that you 

use this document type for pictures too. You can point to a picture stored on a hard drive as opposed to 

storing it directly in the database. This saves database space and improves database performance by 

keeping the database at a reasonable size. 

Working with Documents 
There are three types of documents that can be used by this feature. Build-in Rich-Text Editor types, 

Image or picture types and links to external documents. Each document must be assigned to a folder to 

either create or use them. 

To create a new Internal Rich-Text document 

  
• Move to the Documents Tree and select the folder that you want to assign the new document 

to. 

• Click on the Add Document option in the ribbon control 

• From the invoked Create New Document dialog, move to the Document Name text box and 

enter a name for your new document. This title can contain up to 30 characters. 

• Move to the Document Type section and select the RTF Document option. 

• Click on the Accept button and the Rich-Text editor will open with your new document ready for 

editing. 

To create a new Picture/Image document 

• Move to the Documents Tree and select the folder that you want to assign the new document 

to. 

• Click on the Add Document option in the ribbon control 



PM Coordinator 

 

Simplicity Software Technologies Inc. | Documents Trees 62 

 

• From the invoked Create New Document dialog, move to the Document Name text box and 

enter a name for your new document. This title can contain up to 30 characters. 

• Move to the Document Type section and select the Picture/Image Document option 

• Click the Accept Button to invoke a file open dialog box. 

• Browse to where the images file is store and select the image by clicking on it. 

• Click on the Open button to assign the image. 

To create a new Link document 

• Move to the Documents Tree and select the folder that you want to assign the new document 

to. 

• Click on the Add Document option in the ribbon control. 

• From the invoked Create New Document dialog, move to the Document Name text box and 

enter a name for your new document. 

• Move to the Document Type section and select the Attachment/Link Document option 

• Click the Accept Button to invoke the Link Setup dialog. 

 
• Move to the Attachment Path section and click on the Browse button. 

• Navigate to where the file you want to use is stored. Select the file and click Open. 

• The program will ask if you want to replace the current description with one based on the file’s 

name. To accept the new description reply by clicking on the OK button. 

• You can edit the document’s description by editing the text in the Description section. 

• You can test the link by clicking on the Test/Open button. 

• When everything is set to your liking, click on the Accept button. 

 To open or view a document 

• Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 
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• To open the document: 

o Right click on the document to invoke a pop up menu. Select the View Document 

option. Or… 

o Double click on the document to open it.  

 

To edit a document 

• Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

• Right click on the document to invoke a pop up menu. Select the Edit Document option. 

• For the Rich-Text type documents the document will be displayed in the Editor. For the other 

two document types you will edit a document’s properties in the same manner it was created. 

To move or reassign a document to different parent folder 
• Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

• Right click on the document to invoke a pop up menu. Select the Move to Folder option. 

 
• From the Move Document dialog move and select the folder you want to move the document 

to from the displayed tree. 

• Once the Folder is selected click on the Move to Folder button. 

To rename a document 

• Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

• Right click on the document to invoke a pop up menu. Select the Rename Document option. 

• From the Rename Document dialog edit or rename the document’s title in the space provided. 
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• Click OK to apply the changes. 

To delete a document 

• Move to and click on the folder that contains your document from within the Documents Tree 

to display the documents assigned to that folder. 

• Right click on the document to invoke a pop up menu. Select the Delete Document option. 

• When prompted about deleting the document, click the Yes button. 
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Work and Requests Module 

This module was primarily designed for use as a ‘Work Requests’ module where the users only needs to 

fill out the information on a single page in the creation of new work requests. As this is already 

considered a very simple process, you can also use a Work Order Wizard that simplifies the process 

even further. 

 

This module is designed for use with standard work orders, which includes 6 types with user definable 

titles, and one fixed, Standard Work Order type. We believe you'll find this module much easier to use 

for these types of work orders than the Maintenance Scheduler module. With that said however, the 

system power users, or administrators would normally want to use the Maintenance Scheduler module. 

The Maintenance Scheduler module can handle all work order types available and provides many 

additional features over this module, and overall is considered more powerful. 

You also want to use the Maintenance Scheduler module to add items, such as Classification 

assignments, Projects and the like to the database for use with both of these modules. You can setup 

and customize the work order print settings with the Maintenance Scheduler module, along with the 

custom user defined titles. 

All works orders when first created are assigned a status of Work Requests. Your system coordinator 

needs to only sort the database by this status to quickly find all work requests. He can then perform 

whatever action he wants with these tasks. 
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Ribbon Control 
The comprehensive functionality of the Work and Request module is provided via a set of Ribbon tabbed 

pages. Ribbon pages are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 

WORK ORDERS TAB 

 

The following are the elements on the Work Orders ribbon tab, reading left to right: 

• Add New – Creates a new work order document through the use of a wizard, or directly on 

screen. 

• Save Changes – Saves all current changes from all elements of a record (master save). 

• Print Work Order – Allows selecting a printer, number of copies, etc. prior printing the current 

work order. 

• Print Preview – Provides a print preview for the selected work order. 

• Filter Wizard - Launches the Custom Filter Wizard dialog that allows specific criteria to be setup 

to filter the database by. Please refer Main Report – Filter Wizard section in this chapter. 

• Filter by Requester - Filters the database by a selectable, assigned employee as it applies to 

Requester’s field.    

• Default Filter – Re-filters the database by default values (all open). 

• Main Report Wizard - This report uses a Wizard that allows the user to setup the criteria to use 

for the report creation. Please refer Main Report – Filter Wizard section in this chapter. 

• Search - Invokes the search/find routine on the Lookup Grid. 

FILTERS TAB 

 

The following are the element of the Filters ribbon tab, reading left to right: 

• Mechanic Assignment - Filters the database by a selectable, assigned mechanic or employee.   

• Mechanic Today - Filters the database by a selectable, assigned employee with work orders with 

a scheduled start date of today. 
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• Asset - Filters the database by a selectable, assigned asset. 

• All Open – Filters the database by all work orders that do not have a status of ‘Completed’. 

• Work Requests – Filters the database to view only those records with a status of Work Request. 

• Past Due – Filters the database by all records with a scheduled completion date prior to today, 

and a status of still being open. 

• Show All- Shows all work orders regardless of status. 

• Classifications Assignments – Filters the database by a selectable, assigned classification.     

• Filter by Location – Filters the database by a selectable, assigned location. 

Features of the Work Requests Module 
There are many features of the Work and Requests module, with the majority of these features found 

on either the tabbed pages found there, or within the tabbed ribbon control. We are going to explain 

the use of these features as we move through the tabbed pages. 

Lookup Tab 
This tab helps in locating work orders by grouping, filtering and sorting them. All the work orders in the 

current filter are located in the grid found there. To select a work order and make it the active record, 

the user needs only to click on the work order from within the grid. Once selected the user can click on 

the other tabs to view or edit the work order itself. 

The following image illustrates the features available on the Lookup tab: 

 

The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab. Pay special attention to the following: 

• Using the Lookup Grids 

• Searching 

• Scanned Lookups (Barcodes Support) 
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Details Tab 
Under the Details tab you can setup your scheduling information, equipment, classification assignments, 

labor resources and other work order specifics. 

Work Order Identification 
This section allows you to specify a subject for your work order, a task ID, and the location to be used in 

the execution of the work order. 

The following image illustrates the elements of the section: 

 

Subject 
This field can contain up to 100 alpha/numeric characters. Used for identification purposes, this should 

provide a brief description of the work order as it relates to the work to be performed. 

Task ID 
This field can contain up to 20 alpha/numeric characters and is normally created for you by the 

application.  It uses the following format: YYMM-###, where YY is the year of work order creation, MM 

for the month of creation, and ### a sequential number. 

If wanted, this field can be overwritten, but this is not advised. Also having a unique ID is not enforced. 

However, to verify that it is unique you can click on the Check button adjacent to this field. 

Location 
This field can contain up to 50 alpha/numeric characters and is used to describe the physical location of 

where this work order is to be performed. 

Created 
This is set when a new work order is created. 

Assigned Assets 
You can assign an unlimited number of assets to a work order. However, only one of these will be used 

as the Primary Asset. Most of the available reports will be based on the Primary assignment. 

The following image illustrates the elements of this section: 
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To assign an asset to the work order: 

• Move to the Assigned Assets section and click on the Append (+) button in the data control 

found there. 

• From the invoked lookup dialog, click on the asset record you want to assign. 

• Click on the Select button. 

• Click the Post (check) button in the Assets’ data control to save your changes. 

To set which asset to assign as the primary asset: 

• Click on the asset you want to assign from those listed. 

• Click the Set Primary Asset button.  

• Click Yes to the prompt about setting the primary asset. 

• The asset should be displayed in the Primary Asset field. 

To remove an asset from the current work order: 

• Click on the asset you want to remove from those listed. 

• Click on Remove (minus sign) button in the Assets’ data control. 

• When prompted about the removable, click on the Yes button. 

• Click the Post (checkmark) button in the Assets’ data control. 

To use the Auto Subject feature in this section: 

• Click on the Auto Subject button found in this area. 

• When prompted about accepting this new Subject title, click OK. 

The auto subject feature combines the assigned work order type with information about the assigned 

primary asset to create a Subject title for the current work order, replacing any existing title. 

Work Order Settings 
The section allows you to setup the Task Type of the work order, the priority indicator, and the 

estimated downtime. 

The following image illustrates the elements of the section: 
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Task Type (Work Order Type Assignment) 
There are 7 possible task types available, with 6 of these having user definable titles. See the Work 

Orders Setup section of the Maintenance Scheduler chapter for more information.  

To assign a Task Type to your work order: 

• Click on the down arrow attached to this field. 

• Click on the value you want to assign from those listed. 

Priority 
You can assign your work orders a priority indicator. Options include: Urgent, High, Normal and Low. 

To assign a Priority to your work order: 

• Click on the down arrow attached to this field. 

• Click on the value you want to assign from those listed. 

Estimated Down Time 
You can record the estimated time you feel will be needed to completed a work order. This information 

shows on the work order itself, and can be used with reports. 

To assign the Estimated Downtime for your work order: 

• Click on the down arrows adjacent to the HRS and MINS fields. 

• Click on the value that you want to assign from those listed. 

Work Requested By 
This section allows you to specify who requested this work to be performed. 

The following image illustrates the elements of this section: 
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To assign who request this work order: 

• Move to the Work Requested By group and click on the Select button. 

• From the invoked lookup dialog, select the mechanic you want to assign and click on the Select 

button. 

To email the requester: 

• Move to the Work Requested By group and click on the Open button 

Work to Be Performed 
This section allows you to create tasks instructions to be used with Repair types of work orders. The 

following illustration shows the elements of this section. 

 

To edit repair instructions or comments 

• Select the work order you want to edit instructions for. 

• Move to the Details tab. 

• Move to the Work to be Performed group. 

• Perform one of the following: 

o Type in your instructions or comments in the editor found there. 

o Click on the Open with Editor to edit your instructions or comments with the invoked 

Repair Procedures Editor, clicking on the Save and Close button in the ribbon when 

done. 

For more information on the editor, please refer to the Repair Procedures Editor in the Maintenance 

Scheduler chapter.  

To use the Auto Subject feature in this section: 

• Click on the Auto Subject button found in this area. 

• When prompted about accepting this new subject title, click OK. 

This auto subject is based on the Work to be Performed text as entered in the section editor. 
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Administrator Tab 
The Administrator Tab does not need to be accessed by the person requesting work to be done. They 

really only need to fill in the information on the Details tab. Your system administrator would use this 

tab to accept and make assignments for the work order. 

Work Order Scheduling 
This area sets up the work order scheduling criteria.  

The following image illustrates the elements of this section: 

 

Start Date and Time 
These values would indicate the Scheduled date and time you would like work to commence on the 

work order. 

To set these values: 

• Click on the down arrows attached to these fields. 

• Click the value you want to use from the drop down list. 

End Date and Time 
These values would indicate the Scheduled date and time you would like work to be completed by. 

To set these values: 

• Click on the down arrows attached to these fields. 

• Click the value you want to use from the drop down list. 

Assignments 
This section allows you make some general type assignment to your work order. These assignments help 

with the creation of reports. 

The following image illustrates the elements of this section: 
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To make the assignments in this section: 

• Move to the appropriate field with ellipse (…) buttons and click on the button. 

• From the invoked lookup dialog, move to the grid and click on the record of your choice. 

• Click on the Select button. Or 

• Move to the appropriate field and click on the down arrow on the drop down list. 

• Make your selection by clicking on it. 

Work Order Status 
The following illustrates the elements found in this section: 

 

To change the Status of the current work order 

• From the Administrator tab, move to the Work Order Status group. 

• Select the status indicator your want to assign from the drop down list. Available options 

include: 

o New Request 
o Waiting Approval 
o Waiting on Parts 
o Waiting on Labor 
o Waiting on Production 
o Waiting on Contractor 
o On Hold (General) 
o Ready 
o In-Progress 
o Completed 
o Disapproved 

• Move to the % Completed field to record this information. 
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To Send Status to Requester 

• From the Administrator tab, move to the Work Order Status group. 

• Click on the Send Status to Requester button. 

• When prompted about sending the email, click Yes. 

Work Order Completion Information 
This section allows you to record completion information as it relates to the currently selected work 

order.  

The following illustrates the elements found in this section: 

 

• Date Completed – Use the drop down calendar adjacent to this field to set the date the work 

order status was changed to ‘Completed’. 

• Completed By – Use the Select button adjacent to this field to assign an employee to this field.  

• Inspected By – Use the Select button adjacent to this field to assign an employee to this field.  

• Meter Value – This field would indicate the meter value, if applicable, of the primary asset at 

the time the work order was completed.  

• Get Current – Clicking this button will cause the program to read the Primary Asset’s record and 

retrieve its current meter value and insert it in to the Meter Value field. 

• Actual Down Time – Use the Hours and Minutes fields found here to record the actual time it 

took to complete the selected work order. 

• Save to History – Clicking this button will save a summary of the completed work order to 

Primary’s Asset History Log. 

Completion Notes and Delays 
Use the editor found in this area to record any information as it applies to completion notes and delays. 

You can also click on the Open with Editor button to edit this information with a text editor. 
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Add New Work Order 
To add a new work order: 

 

• Move to the Work and Requests module. 

• Move to the Work Orders tab in the ribbon and click on the Add New button. 

• When prompted about the operation, click on the response of your choice. 

o Yes – Launches the Work Order Wizard that steps you through the creation process. 

This wizard will be explained later in this chapter. 

o No – Creates a new work and returns you to the Details tab where you can move 

through the fields editing and adding information as necessary. 

o Cancel – Backs out of the creation process. 

Save Changes 
To save changes to the main work order record, click on the Post (✓ check) button in the Data Control 

located within the ribbon’s Quick Access toolbar. 

To save changes to the main work order record and all the underlying records (assets, etc.), click on the 

Save Changes button found on the Work Orders tab of the ribbon control. 

Export the Current Work Order 
To export the currently selected work order: 

• Select the work order you want to export. 
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• Open the File menu and select the Export Work Order option. 

• Browse and select the folder you want to export to. 

• Type in a name for the export file in the File name text box. 

• Move to the Save as type drop down and select the export file type of your choice. 

• Click the Save button. 

Printing the Current Work Order 
To print the current work order: 

• Open the File menu and expand the Print sub-menu by clicking on it. 

• Select the print option of your choice. 

Work Order Wizard 
The Work Order Wizard when accessed from this module will help ease in the work order creation by 

stepping you through the process. This wizard is also accessible from the Issues Tracking Modules, 

Safety Management and the Personal Manager. 

The following illustration shows the general or shared features of the Wizard: 

   

• Tab Pages – This is a logical way of grouping controls by function. 

• Previous – Clicking this button moves you to the previous tab. 

• Next – Clicking the button moves you to the next available tab. 

• Save and Close – Clicking this button saves any changes you may have made, and closes the 

Wizard. 

• Cancel – Clicking this button closes the wizard without applying any changes made. 
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Wizard Identification Tab 
The following illustration shows the elements on this tab: 

 

• Subject – This is a brief description of the work order. It can contain up to 100 alpha/numeric 

characters. 

• Task ID – This is generated for you by the program. You are allowed to edit this value, but it is 

not recommended. 

• Check – This checks to ensure that the supplied Task ID is unique in the database. If it was 

generated by the program then is already known to be unique. 

• Location – This specifies the location at which the work order will be performed, and is 

selectable from the drop down list. 

• Task Type - There are 7 possible task types available, with 6 of these having user definable titles. 

See the Work Orders Setup section of the Maintenance Scheduler chapter for more 

information.  

Wizard Equipment Tab 
You can assign an unlimited number of assets to a work order. The following image illustrates the 

elements of this section: 
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To assign an asset to the work order: 

• Move to the Assigned Assets section and click on the + (plus sign) in the data control found 

there. 

• From the invoked lookup dialog, click on the asset record you want to assign. 

• Click on the Select button. 

Wizard Requester Tab 
This section allows you to assign the person requesting the work to be performed. 

The following image illustrates the elements of this section: 
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To assign who requested this work order: 

• Move to the Requester field and click on the Select button. 

• From the invoked lookup dialog, select on the employee you want to assign and click on the 

Select button. 

To allow a Completion Notice to be sent to the requester: 

• Check the Send Completion Notice checkbox 

Wizard Work to be Done Tab 
The following illustration shows the elements on this tab: 

 

 

To include work instruction for repair types of work orders 

• Move to the Work to be Performed section and edit your instructions in the editor found there. 

You can also click on the Open with Editor button found in this area and use the Repair 

Procedures Editor discussed in the Maintenance Scheduler chapter. 

Wizard – Save and Close 
Whenever you either make changes to work orders, or create a new one with Work Order Wizard, 

ensure to save your changes. 

• Click on the Save and Close button to save and apply your changes. 
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Main Report – Filter Wizard 
This Wizard is used or both the Filter Wizard and Main Report Wizard of the Work and Request Orders 

module. When used for either filtering or reporting purposes, the resulting items will be returned by the 

choices or criteria as setup with this wizard. 

Types and Status tab 
The following illustrates the elements found on this tab: 

 

• Work Order Types – This drop down allows for the selection of the types of work orders to be 

included. Make your selection by clicking on an item in the drop down list. 

• Work Order Status – This drop down allows for the selection of the work orders status indicator 

to be included. Make your selection by clicking on an item in the drop down list. 

Assignments tab 
The following illustrates the elements found on this tab: 
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• To assign values to these fields: 

o Move to the appropriate fields and click on the Select button adjacent to them. 

Available options include: 

▪ Requester 

▪ Classifications 

▪ Locations 

▪ Projects 

▪ Assets/Equipment 

▪ Mechanic (Employee) 

o From the invoked dialogs, move to the displayed grid and click on the record of your 

choice. 

o Click on the Select button.  

• To clear the assignments: 

o Move to the appropriate field and click on the Use All button adjacent to them. 
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Dates and Sorting Tab 
The following illustrates the elements found on this tab: 

 

To assign date values: 

• Move to the Start Date field and using the drop down calendar, select the starting date of your 

filtering criteria. 

• Move to the End Date field and using the drop down calendar, select the ending date of your 

filtering criteria. 

• To ignore or use all available dates, check the Use All Dates checkbox. 

• To use completion dates, place a checkmark in the Use Completion Dates checkbox. Otherwise, 

Scheduled Start Dates will be used. 

• Move to the Sort By drop down, and select how you want things sorted by. 

• With everything setup as wanted, move to and click on the Accept button. 

Main Report Wizard 
This report uses the Main Reports – Filter Wizard for the creation of report criteria.  Please refer to the 

Main Reports – Filter Wizard section of this chapter for more information. The only elements of this 

wizard that is not explained with this wizard is outlined next. 

These options are found on the Dates and Sorting tab of the wizard. 

• Include Task Instructions – When checked, the report will include all task instructions as 

assigned to each of the reported work orders. 
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• Include Delays and Completion Comments – When checked, the report will include all Delays 

and Completions comments that were recorded for each of the reported work orders. 

To create a Work Orders Summary Report: 

• Move to the Work Orders tab in the ribbon.  

• Click on the Main Report Wizard option. 

• Follow the instructions as outlined in the Main Reports – Filter Wizard section of this chapter.  

The following illustration shows a preview of a Work Orders Summary Report: 
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Maintenance Scheduler  

The Maintenance Scheduler module is the heart of all CMMS type programs, and you’ll find ours to be 

extremely powerful, feature rich, and easy to use. The Maintenance Scheduler module was designed to 

handle all work order types. These include recurring and one time, or repair types of work orders. 

 

One of the most valuable features of this module is found in its ability to create and use recurring work 

order type tasks. Once a work order has been setup, the program will handle the responsibility of 

keeping track of when the work order is next due to be performed, and will schedule it accordingly, and 

automatically as the module is opened. 

This module also accommodates for the easy creation of reports, and when possible, it employs the use 

of report wizards. With the wizards you can create some fairly custom reports, specifying the criteria 

needed for the report creation. These reports will allow you to view and analyze information in a way 

that is right for you and your organization. 

The system supports 5 recurring work order types, 4 of these have user definable titles. There are 7 

standard, or repair types of work orders, with 6 of these having user defined titles. Out of these 11 work 

order types, 2 are designated as Contractor/Vendor types, with 1 belonging to the repair, one-time 

group, and the other one belonging to the recurring, PM types group. 
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Printed Work Order Documents 
The next illustration outlines the elements on a printed work order document. Most of these elements 

can be turned on or off and further customized through the Work Orders Setup.  
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Work Orders Setup 
The Scheduler module allows you to setup various options for use with this and the Work Requests 

modules. This includes elements on the printed documents, view options, and other general features. 

To access the Work Orders Setup screen: 

 

• Move to the Main Scheduler. 

• Click on the File button in the ribbon and click the Work Orders Setup option. 

General Tab 
This tab allows you to specify the following options: 

GLOBAL SETTINGS 

• Next Work Order Number -The number here specifies the next sequential number to use in the 

automatic work order number generation. These numbers use the following format: yymm – xx. 

Where yy equals the year of task creation, mm equals the month of task creation, and xx is a 

sequential number. 

• Days in Advance to Generate Work Orders - To help keep the database at a reasonable size, we 

allow you to specify how many days in advance to generate or display work orders. 

• Work Order Types - Document Control Number: This is the ISO document control number you 

want to assign to repair types of work orders. 

• PM Types - Document Control Number - This is the ISO document control number you want to 

assign to recurring types of work orders. 

• Do No Generate New Work Orders for Weekends - Selecting this option will prevent new work 

works from being scheduled on weekends. If it does fall on a weekend, it will be moved to the 

following Monday. This applies to auto recurring work orders only. 



PM Coordinator 

 

Simplicity Software Technologies Inc. | Work Orders Setup 87 

 

• Generate New Work Orders for In-service Equipment Only - Selecting this option prevents the 

automatic creation of new work orders when the assigned equipment record has not been 

placed in service. Please refer to the Equipment and Assets chapter for more information. 

• Default Times: Allows you to setup the default ‘Scheduled’ Start and End Times to be used as 

new work orders are created. Change the values by selecting new values from the drop down 

lists. 

 

LOCAL SETTINGS 

• Allow Past Due Notification of Work Orders: Selecting this option allows a popup to be 

displayed when you first enter the Maintenance Scheduler module. This signals the user about 

work orders that are still open, but the scheduled completion dates have past. You then have 

the option of filtering the database by only past due work orders. 

NOTE: Global Settings are applied throughout the system, and from wherever the application is 

running from. Local Settings on the other hand only apply to the local computer from where these 

settings were made. 
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Recurring PM Types Tab 
This tab allows you to setup the Work Type Titles to be used for recurring, or PM types of work orders. 

You can specify the colors to be used by the printed documents’ section headers. To conserve ink with 

these documents we suggest using a light, or even a white/clear color. 

 

To change a Title 

• Edit the displayed title to your liking. 

To setup the colors to use 

• Click on the down arrow adjacent to the task Work Order type you want to setup. 

• Select the color of your choice by clicking on it. 

One-Time WO Types Tab 
This tab allows you to setup the Work Type Titles to be used for one-time, or repair types of work 

orders. You can specify the colors to be used by the printed documents’ section headers. To conserve 

ink with these documents we suggest using a light, or even a white/clear color. 

To change a Title 

• Edit the displayed title to your liking. 

To setup the colors to use 

• Click on the down arrow adjacent to the task Work Order type you want to setup. 

• Select the color of your choice by clicking on it. 
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PM Print Elements Tab 
Select the options on this tab that you want printed on your recurring types of work order documents. A 

checkmark indicates the item will be printed. Removing the checkmark will prevent printing. 

 

With the Material List, Completion Information (Sign-offs) and Recording of Completion Steps sections, 

you have the ability to print 1 to multiple lines of information for the purpose of recording this 

information. 

To specify the number of lines to print on the documents: 

• Move to the Spin buttons adjacent to these fields and near the # of Lines area. 

• Using the Up or Down arrows, adjust these values to the number of lines you want printed. 

WO Print Elements Tab 
Select the options on this tab that you want printed on your recurring types of work order documents. A 

checkmark indicates the item will be printed, removing the checkmark prevent the item from printing. 

With the Material List, Completion Information (Sign-offs) and Recording of Completion Steps sections, 

you have the ability to print 1 to multiple lines of information for the purpose of recording this 

information. 

To specify the number of lines to print on the documents: 

• Move to the Spin buttons adjacent to these fields and near the # of Lines area. 

• Using the Up or Down arrows, adjust these values to the number of lines you want printed. 
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User Fields Tab 

 

This tab allows you to setup the following elements: 
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• Use User Defined Fields – Placing a checkmark here will cause the user-defined fields to show 

up on the printed document. 

• Work Orders User Defined Fields – This allows you to specify the default user defined fields’ 

titles that will be filled in for you when a new work order is created. You can change these on 

the original work order at any time after the creation process is completed. 

• Use Custom Comments – Placing a checkmark here will cause the program to use your custom 

Comments Section title. Leaving this unchecked will cause the program to use its own built in 

title of “Comments”. 

• Custom Title - Here you would specify the custom title you would like to use for the Comments 

field of PM types of work orders. 

Ribbon Control 
The comprehensive functionality of the Main Scheduler is provided via a set of Ribbon tabbed pages. 

Ribbon pages are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 

HOME TAB 

 

The following are the elements on the Home ribbon tab, reading left to right: 

• Add New – Creates a new work order document through the use of a wizard, or directly on 

screen. 

• Save Changes – Saves all current changes from all elements of a record (master save). 

• Refresh – Re-reads the databases and returns new or changed information. 

• Generate Today – Shows all work orders scheduled to start today and allows printing these 

work orders. 

• Generate Options 

o Generate by Dates – Allows you to view and print all work orders that fall with a date 

range. 

o Generate by Classification - Allows you to view and print all work orders that fall within 

a date range and has a specific classification assignment. 

o Generate by Location - Allows you to view and print all work orders that fall within a 

date range and has a specific location assignment. 

• Search – Invokes the search routine on the Lookup Grid as explained in the Common Features 

chapter. 

• Exit – Close the Maintenance Scheduler module. 
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WORK ORDERS TAB 

 

The following are the elements found on the Work Orders tab: 

• Work Labor – Allows you to assign mechanics’ estimated and actual times needed in the work 

order completion. 

• Recur – Provides options for recurring work order types. 

o Set Next Meter – Allows you to specify the meter value of the Primary Asset to reach, 

for the current work order to become due. 

o Change ‘Do Not Generate’ flag – This allows you to either start or stop a recurring work 

from regenerating itself. 

• Copy Work Order – Makes a copy of the current work order fields for re-insertion. Note: Only 

the primary fields are copied. 

• Paste Work Order – Pastes a previously copied work order over the currently selected one. 

FILTERS TAB 

  

The following are the elements found on the Filters tab: 

• Work Requests – Filters the database to view only those records with a status of Work Request. 

• Paste Due – Filters the database by all records with scheduled completion date prior to today. 

• Custom Filter – Launches the Custom Filter Wizard dialog that allows specific criteria to be setup 

to filter the database by. See the Main Reports – Filter Wizard section form more information. 

• Default Filter – Removes custom filter and reapplies the default filter. 

• Show All Works Orders – Removes all filters and returns every work order in the system. 

• Open All Dates – Shows all work orders that have yet to be completed or closed. 

• On-Hold – Filters the database to show all work orders with a status of ‘on-hold’, or waiting for 

some action to occur. 

• Set to Regenerate – Shows all recurring types of work orders that have not regenerated, and do 

not have the ‘Do Not Regenerate’ flag set. 

• With Current Description – This is based on the subject field of the currently selected work 

order. 

o Show All Records – Shows all work orders with the current subject text. 
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o Open Records Only – Shows all work orders with the current subject that still have an 

open status. 

o Closed Records Only – Shows all work orders with the current subject, and have a status 

of Completed. 

o Set to Regenerate – Shows all work orders with the current subject and do not have the 

‘Do Not Regenerate’ flag set. 

• Assignments 

o Mechanics – Filters the database by a selectable, assigned mechanic or employee.    

o Assets/Machines – Filters the database by a single, selectable, assigned machine or 

asset. 

o Mechanics – Filters the database by a selectable, assigned mechanic or employee.   

o Classifications – Filters the database by a selectable, assigned classification.     

o Location – Filters the database by a selectable, assigned location. 

INSTRUCTIONS TAB   

 

The following are the elements found on the Instructions tab: 

• Safety Instructions – Allows for the creation and editing of the Safety Instructions database. 

• Recurring (PM) Instructions – Allows for the creation and editing of the reusable, recurring tasks 

Instructions database. 

• Work and Comments – Allows for the creation and editing of the work to be done/comments 

instructions database. 

REPORTS TAB 

 

The following are the elements found on the Reports tab: 

• Main Summary – This report uses a Wizard that allows the user to setup the criteria to use for 

the report creation. 

• Current W.O. (Current Work Order) 



PM Coordinator 

 

Simplicity Software Technologies Inc. | Ribbon Control 94 

 

o Work Order Details – This report returns information on the currently selected work 

order, and can also be considered a status report. 

o Estimated Costs – This report returns information to the estimated costs associated 

with the currently selected work order. 

• Completed WOs (Completed Work Orders) 

o Work Orders Costs – This report uses a criteria selection wizard to return costs 

information on work orders of your choice. Also includes a chart to help present the 

information returned. 

o Down Time Wizard - This report uses a criteria selection wizard to return costs 

information on work orders of your choice. Also includes a chart to help present the 

information returned. 

o Completion Analysis – Using a date range, this report returns information on the 

percentage of work orders that were completed on-time, late, etc. Also includes a chart 

to help represent the information returned. 

o Repair Codes – This reports on a single asset and one or all associated repair codes. 

• Summary Reports 

o Equipment Summary – This report uses a criteria selection wizard to return a summary 

of costs and downtime information. Also includes a chart to help present the 

information returned. 

o Completion Summary– This report uses a criteria selection wizard to return a summary 

of costs, labor and downtime information.  

• Labor Resources 

o Open by Mechanic – This reports on all open work orders assigned to a single mechanic. 

o Closed by Mechanic – This reports on completed work orders for a date range and 

assigned to a single mechanic. 

o Overdue by Mechanics – This reports on all overdue work orders assigned to a single 

mechanic. 

• Labor Time 

o Projected Man Hours – This reports on work orders projected time needed based on a 

date range, asset and/or mechanic. 

o Actual Man Hours – This reports on work orders actual time used based on a date 

range, asset and/or mechanic. 

o Time Card Report – This reports on information as collected with the Time Tracker 

feature. 

• Open WOs (Open Work Orders) 

o Open by Primary Asset - This reports on all open work orders assigned to a single asset. 

o Projected Costs– This report uses a criteria selection wizard to return a summary of 

projected costs by category (labor, parts, etc.). 

o Past Due Work Orders – Reports on all work orders that have a scheduled completion 

earlier than today’s date and have a status of open. 

o Open Work Requests – Reports on all work orders with a status of Work Request. 
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Lookup Tab 
This tab helps in locating work orders by grouping, filtering and sorting them. All the work orders in the 

current filter are located in the grid found here. To select a work order and make it the active record, 

the user needs only to click on the work order from within the grid. Once selected the user can click on 

the other tabs to view or edit the work order itself. Also note that double clicking on a work order will 

move you to the Details tab showing the selected record. 

The following image illustrates the features available on the Lookup tab: 

 

The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab. Pay special attention to the following: 

• Using the Lookup Grids 

• Searching 

• Scanned Lookups (Barcodes Support) 

Details Tab 
Under the Details tab you can setup your scheduling information, equipment, classification assignments, 

labor resources and other task specifics. 
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Work Order Identification 
This section allows you to specify a subject for your work order, a task ID, and the location to be used in 

the execution of the work order. 

The following image illustrates the elements of the section: 

 

Subject 
This field can contain up to 100 alpha/numeric characters. Used for identification purposes, this should 

provide a brief description of the work order as it relates to the work to be performed. 

Task ID 
This field can contain up to 20 alpha/numeric characters and is normally created for you by the 

application.  It uses the following format: YYMM-###, where YY is the year of work order creation, MM 

for the month of creation, and ### a sequential number. 

If wanted, this field can be overwritten, but this is not advised. Also having a unique ID is not enforced. 

However, to verify that it is unique you can click on the Check button adjacent to this field. 
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Location 
This field can contain up to 50 alpha/numeric characters and is used to describe the physical location of 

where this work order is to be performed. 

Work Order Scheduling 
This area sets up the work order scheduling criteria. This section needs not to be filled in manually when 

the work order has been assigned to a PM group. 

The following image illustrates the elements of this section: 

 

Created 
This is set to the date the work order was created, either by the user or automatically by the program as 

in the case of recurring work order types. 

Start Date and Time 
These values would indicate the Scheduled date and time you would like work to commence on the 

work order. 

To set these values: 

• Click on the down arrows attached to these fields. 

• Click the value you want to use from the drop down list. 

End Date and Time 
These values would indicate the Scheduled date and time you would like work to be completed by. 

To set these values: 

• Click on the down arrows attached to these fields. 

• Click the value you want to use from the drop down list. 

Work Order Recurrence 
The information in this area needs to setup when the current work order is assigned as one of the 

available recurring types, such as a recurring PM for example. 
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Note:  Like the Scheduling section, this information does not require manual setup if the work order has 

been assigned to a PM group. 

The following image illustrates the elements of this section: 

 

Frequency 
This Frequency field allows you to specify the frequency at which the recurring work order will recreate 

(regenerate) itself. 

To setup the Frequency: 

• Click on the down arrow attached to this field. 

• Click on the value you want to assign from those listed. 

Available values are: 

• None 
• Every XX Meters (*see note below) 
• Every XX Days 
• XX Days (Mon-Fri) 
• Daily 
• Daily (Mon-Fri) 
• Weekly 
• Bi-Weekly 
• Every XX Weeks 
• Monthly 
• Bi-Monthly 
• Every XX Months 
• Quarterly 
• Semi-Annually 
• Annually 
• Every XX Years 

 
*Please refer to the section ‘Scheduling by Meters’ for more information when the’ Every XX Meters’ 

frequency is assigned.  
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XX Criteria 
If the selected Frequency has XX anywhere in its description, the XX Criteria value must also be 

provided. This field only accepts numeric values. 

To assign the XX Criteria value, please do one of the following: 

• Click the up arrow to increase the value here. 

• Click the down arrow to decrease the value here. 

• Click and type in your value in the space provided. 

The value entered here replaces the ‘XX’ criteria of the selected frequency. For example, if you have a 

Frequency of ‘Every XX Meters’ selected, and you enter ‘3000’ for the XX Criteria, the work order would 

regenerate ‘Every 3000 Meters’. 

Generate New When Done 
When this value is set, the program will not generate a new work order until the current work order is 

marked as completed. 

To set the Generate New When Done flag: 

• Place a checkmark in the Generate New When Done checkbox. 

Note about using this option: When this option is used, the selected recurring frequency value will be 

added to the work order’s completion date. For an example: If you have a recurring frequency set for 

‘Every 10 Days’, and the work order has a completion date of the 10th of the month, the newly 

generated work order would have a scheduled start date of the 20th (Completion Date + 10). 

Using the example above, and the Generate New When Done is not used, the newly generated work 

order would have a scheduled start date of 10 days in the future of the current work order’s ‘scheduled 

start date’ (not the completion date), regardless if the current work order is completed or not.  

Do Not Regenerate 
For recurring types of work order, setting this value will prevent the program from regenerating the 

work order at the set frequency. Also be aware that as the program executes one of the built-in 

regeneration routines, it will automatically set this flag. This basically does two things: 

• It tells the application and the user that the work order has already regenerated itself and a new 

one should already be present in the database. 

• It prevents the program from regenerating the ‘same’ work order again. Thereby preventing 

possible duplicates from being created. 

To manually change the Do Not Regenerate value (Allowed but not recommended): 

• Move to the Work Orders tab in the ribbon. 

• Click on the Recur option to expand the drop down. 
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• Click Change ‘Do Not Regenerate’ flag. 

• Click Yes to the prompt. 

Work Order Settings 
The section allows you to setup the Task Type of the work order, the priority indicator, and the 

estimated downtime. 

The following image illustrates the elements of the section: 

 

Task Type (Work Order Type Assignment) 
There are 12 possible task types available, with 10 of these having user definable titles. Five of these 

task types are designated as recurring types of work orders, where the others are designated as repair, 

or one-time work orders types. See the Work Orders Setup section in this chapter for more information.  

To assign a Task Type to your work order: 

• Click on the down arrow attached to this field. 

• Click on the value you want to assign from those listed. 

Note that the top 5 task types listed are recurring types, with the remaining types being one-time or 

repair types. 

Priority 
You can assign your work orders a priority indicator. Options include: Urgent, High, Normal and Low. 

To assign a Priority to your work order: 

• Click on the down arrow attached to this field. 

• Click on the value you want to assign from those listed. 

Estimated Down Time 
You can record the estimated time you feel will be needed to completed a work order. This information 

shows on the work order itself, and can be used with reports. 

To assign the Estimated Down Time for your work order: 

• Click on the down arrows adjacent to the HRS and MINS fields. 
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• Click on the value you want to assign from those listed. 

Assigned Assets 
You can assign an unlimited number of assets to a work order. However, only one of these will be used 

as the Primary Asset. Most of the available reports will be based on the Primary assignment. 

The following image illustrates the elements of this section: 

 

To assign an asset to the work order: 

• Move to the Assigned Assets section and click on the + (plus sign) in the data control found 

there. 

• From the invoked lookup dialog, click on the asset record you want to assign. 

• Click on the Select button. 

• Click the Post (check) button in the Assets’ data control. 

To set which asset to assign as the primary asset: 

• Select the asset you want to assign from those listed in the grid. 

• Click the Set Primary Asset button.  

• Click Yes to the prompt about setting the primary asset. 

• The asset should be displayed in the Primary Asset field. 

To remove an asset from the current work order: 

• Click on the asset you want to remove from those listed. 

• Click on Remove (minus sign) button in the Assets’ data control. 

• When prompted about the removable, click on the Yes button. 

• Click the Post (check) button in the Assets’ data control. 

To use the Auto Subject feature in this section: 

• Click on the Auto Subject button found in this area. 

• When prompted about accepting this new Subject title, click OK. 
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The auto subject feature combines the assigned work type with information about the assigned primary 

asset to create a Subject title for the current work order, replacing any existing title. 

Primary Work Assignments 
The Primary Work Assignments section allows you to assign 3 employees or mechanics, and one 

Manager to the current work order. These resources will be shown on the printed document, and also 

used with the Auto Email of work orders. 

The following image illustrates the elements of this section: 

 

To assign mechanics or employees to the work order: 

• Move to and click on the Select button adjacent to the Assignment field you want to assign an 

employee to. 

• From the invoked lookup dialog select the record you want to assign from those displayed. 

• Click on the Select button. 

• Repeat the above steps for each assignment you want to make, including the Manager field. 

Options Tab 
The Options tab allows you to continue making general assignments to the current work order. Some of 

the possible assignments are vendors and contractor, auto email features, email list, add attachments 

and more. 
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General Assignments 
This section allows you make some general type assignment to your work order. These assignments help 

with the creation of reports. 

The following image illustrates the elements of this section: 

 

To make the assignments in this section: 

• Move to the appropriate field and click on the down arrow on the drop down list. 

• Make your selection by clicking on it. 

Work Order Repair Code 
With Repair Codes you can have both universal codes, and machine specific codes. With the universal 

codes you can assign the same code to every work order regardless of the machine assignment. 

Examples here may be Normal Maintenance, Scheduled Downtime, etc. 

Machine specific codes can be more specific to what was done, and the list will change according to the 

primary asset assigned to the work order. Examples here could be Main Motor Replacement, Brushes 
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Changed, Main CAM replaced etc. Machine specific repair codes can be used for predictive maintenance 

type reports where you can see trends develop and scheduled preventive maintenance accordingly. 

The following image illustrates the elements of this section: 

 

Assign a Repair Code 
To assign a Repair Code: 

• Move to the Work Order Repair Code section as found on the Options tab. 

• Click on the Select button. 

• Move to the grid and select the repair code you want to use by clicking on it. 

• Click on the Select button. 

Creating New Repair Codes 
To add new items to the Repair Codes List: 

• Select the work order you want to add a repair code to. 

• Move to the Work Order Repair Code section as found on the Options tab. 

• Click on the Select button. 

• Move to the data control located below the grid and click on the Append (+) button. 

 

• From the invoked New Repair Code dialog, type in the title of the new code in the space 

provided. This description can contain up to 40 alpha/numeric characters. 

• Click the OK button. 
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• When prompted about adding the code to either the global list, or the assigned equipment only 

list, click on the appropriate button to make your assignment. 

Work Order Custom Fields  
You can specify two user defined fields to be included or printed with your work orders. These include 

both the field’s caption, and the contents or value of that field. 

The following image illustrates the elements of this section: 

 

To setup your special fields: 

• Move to the Options tab in the Main Scheduler. 

• Move to the Work Orders Custom Fields section and type in the appropriate information for 

that field. 

You can setup the default captions for these fields using the Work Orders Setup routines. Alternately, 

you can also toggle the use of these fields. 

Labor Resources 
You can assign as many mechanics or employees as required to a work order. Those assigned here differ 

from the three possible assignments made in the Primary Assignments section. The resources here will 

be used in the calculation of the total work order costs and time management. Whereas the others 

appear on the work orders assignments section, used in conjunction with the Auto-Email feature and 
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can be used by various filters and reports. It is perfectly acceptable and recommended to use both 

employee assignments when possible. 

To assign Labor Resources to a work order 

• Move to the Options tab in the Maintenance Scheduler module. 

• Move to the Resources tab, located within the Options tab. 

• Click in the Labor Resources button.  

Or 

• Move to the Work Orders tab in the ribbon and click on the Work Labor option. 

 

• Move to and click on the Add button in the Assignments group. 

• From the invoked Employees Database lookup dialog, select the employee you want to add 

from those listed in the grid. 

• Click on the Select button. 

• Click Save Changes button. 

To assign Estimated Time Needed 

• Select the employee you want to make the assignment to from those listed in grid. 

• Move to the Estimated Time Needed area and edit the information found there. 

• Click on the Save Changes button. 

To record Actual Time Used 
• Select the employee you want to make the assignment to from those listed in grid. 

• Move to the Actual Time Used area and edit the information found there. 

• Click on the Save Changes button. 
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Work Order Attachments 
Work Orders found in this module support the attachments feature. For more information about 

attachments please refer to the Attachments section of the Common Features chapter. 

The following illustration outlines the elements of this section: 

 

To access the Attachments: 

• Move to the Options tab in the Main Scheduler. 

• Move to the Attachments tab, which is located within the Options tab. 

Instructions Tab 
The Instructions tab is used to assign and edit instructions used by your work orders. For recurring types 

of work orders these instructions are assigned from lists of predefined instructions. For repair types of 

work orders, these instructions are created as needed. 

Safety Instructions 
This section allows you to specify the safety instructions to be used by the currently selected work 

order. These instructions can also be semi-automatically assigned for you when assigning an asset to a 

work order and this asset has been assigned ‘Default’ Safety Instructions. 

The following illustration shows the elements of this section. 

 

To assign Safety Instructions to the current work order 
• Select the work order you want to assign instructions to. 

• Move to the Instructions tab. 

• Move to the Safety Instructions group and click on the Select button. 

• From the Instructions Lookup dialog, select the instructions you want to assign from those listed 

in the grid. 
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• Click on the Select button. 

To view or edit these assigned instructions: 

• Move to the Safety Instructions group and click on the Edit button. 

• This will open the instructions with the Repair Procedures Editor. 

IMPORTANT NOTE: Editing the assigned instructions will not only apply to this work order, but every 

work order in the system assigned to use these instructions. 

Work Instructions for Recurring Work Orders 
This section allows you to assign as many sets of predefined instructions as may be required to the 

currently selected, recurring type of work order. 

The following illustration shows the elements of this section. 

 

To Add instruction to a Recurring Work Order 

• Select the work order you want to assign instructions to. 

• Move to the Instructions tab. 

• Move to the Work Instructions for Recurring Work Orders group. 

• Move and click on the + (plus sign) in the data control found there. 

• From the invoked lookup dialog, select the instructions you want to assign from those listed in 

the grid. 

• Click on the Select button. 

• Click the Post (check) button in the Instructions data control. 

To view or edit these assigned instructions 

• Move to the Work Instructions for Recurring Work Orders group and select the instructions 

your want to view. 

• Click on the Edit/View button. 

• This will open the instructions with the Repair Procedures Editor. 

IMPORTANT NOTE: Editing the assigned instructions will not only apply to this work order, but every 

work order in the system assigned to use these instructions. 

To remove Instructions from the current Work Order 
• Move to the Work Instructions for Recurring Work Orders group and select the instructions 

your want to remove. 
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• Click on the Remove (minus sign) button in the data control. 

• When prompted about the removable, click on the Yes button. 

• Click the Post (check) button in the data control. 

Comments for PMS or Work to be Performed for Single Shot Work 

Orders 
This section allows you to assign and edit comments for PMs, and create tasks instructions to be used 

with Repair types of work orders. For Repair types of work orders, this is the Work to be Performed 

section. 

The following illustration shows the elements of this section. 

 

To edit repair instructions or comments 

• Select the work order you want to edit instructions for. 

• Move to the Instructions tab. 

• Move to the Comments for PM or Work to be Performed for Single Shot Work Orders group. 

• Perform one of the following: 

o Type in your instructions or comments in the editor found here. 

o Click on the Open with Editor to edit your instructions or comments with the invoked 

Repair Procedures Editor, clicking on the Save and Close button in the ribbon when 

done. 

o Click on the Select button in this area. From the invoked lookup dialog, select the 

instructions you want to assign from those listed in the grid and then click on the Select 

button. 

To use the Auto Subject feature in this section: 

• Click on the Auto Subject button found in this area. 

• When prompted about accepting this new subject title, click OK. 
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This auto subject is based on the Work to be Performed text as entered in the section editor. 

Working with the Instructions Databases 
The Instructions Database is used to store reusable task instructions. This is useful when you want to 

reuse the same set of instructions for various machines, and with recurring work orders. For example, 

let’s say you have a common gearbox that is used throughout your facility. It only makes sense to reuse 

the same set of instructions for all of these gearboxes, instead of rewriting them for each individual 

item. 

Adding New Instructions to the Database 
To add new instructions to the instructions database: 

• Move to the ribbon control and click on the Instructions tab. 

• Click on the option that best describes the type of instructions you want to create. 

o Safety Instructions – These instructions would outline work order safety guidelines and 

could be assigned to any work order type. 

o Recurring (PM) Instructions – These instructions would be used to outline the tasks to 

be performed in the execution of planned maintenance tasks. 

o Work and Comments – These instructions or comments would be used in the 

Comments for PM or Work to be Performed for Single Shot Work Orders section. 

• From the invoked Instructions Lookup dialog, move to and click on the + (plus sign) in the data 

control found there. 

• From the invoked New Instructions dialog box, move to the space provided and type a 

descriptive name for your instructions. This field will accept up to 50 alpha/numeric characters. 

• Click on the OK button. 

• Next you will be prompt as to whether to assign the new instructions to a group. Group 

assignments will help streamline item lookup later. To add the instructions to a group. 

o Click the Yes button to the prompt about adding the group. 

o Select the group you want to use from those listed and click on the Accept button. 

• Next you will be given the chance to edit the actual instructions when the Repair Procedures 

Editor loads. 

• Edit your instructions, clicking on the Save and Close button when done. 

The following illustrates the elements found on the Instructions Lookup dialog: 
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Renaming Instructions Titles 
To rename a set of Instructions’ Title: 

• From the Instructions Lookup dialog, move to the list of available instructions and click in the 

grid that contains the instructions you want to edit the title on. 

• Edit the information from within the grid. 

• Click on Post/Save Changes (checkmark) in the data control.  

Assigning Instructions to a Group 

• From the Instructions Lookup dialog, move to the list of available instructions and click in the 

grid that contains the instructions you want to assign a group to. 

• Move to the Instruction Group Assignment section and click on the Select button. 

• Select the assignment you want to use from those listed. 

• Click on the Accept button to assign the group. 

• Click on Post/Save Changes (checkmark) in the data control.  
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Status Tab 
On the Status tab you will set the current status of your work orders, record costs information, record 

completion information and more. In this section we will explore the features found on this tab. 

Work Order Completion Information 
This section allows you to record completion information as it relates to the currently selected work 

order.  

The following illustrates the elements found in this section: 

 

• Date Completed – Use the drop down calendar adjacent to this field to set the date the work 

order status was changed to ‘Completed’. 

• Completed By – Use the Select button adjacent to this field to assign an employee to this field.  

• Inspected By – Use the Select button adjacent to this field to assign an employee to this field.  

• Meter Value – This field would indicate the meter value, if applicable, of the primary asset at 

the time the work order was completed.  

• Get Current Meter – Clicking this button will cause the program to read the Primary Asset’s 

record and retrieve its current meter value and insert it in to the Meter Value field. 

• Set Current Meter – Clicking this button will allow you to both update the Meter Value field, 

and update the Primary Asset’s meter value in the Assets database. 

• Actual Down Time – Use the Hours and Minutes fields found here to record the actual time it 

took to complete the selected work order. 

• Complete – Clicking this button will invoke the built in Work Order Completion wizard that will 

step you through the completion process.  

• History – Clicking this button will save a summary of the completed work order to Primary’s 

Asset History Log. 

Note on the History option. You should complete all other completion information prior to saving to 

history, as much of this information will be written to the asset’s log. 
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Set Current Meter Value 
To both assign an Asset’s meter to the current work order, and simultaneously update the value of the 

actual primary asset: 

 

• From the Status tab of the Main Scheduler, move to the Work Order Completion Information 

group. 

• Click on the Set Current Meter button. 

• Enter the new meter value in the space provided and then click OK. 

Actual Down Time 
To record the actual time used to completed a work order.  

• From the Status tab of the Main Scheduler, move to the Work Order Completion Information 

group. 

• Click on the down arrows adjacent to the HRS and MINS fields. 

• Click on the values you want to assign from those listed. 

Work Order Status 
The following illustrates the elements found in this section: 

 

To change the Status of the current work order 

• From the Status tab of the Main Scheduler, move to the Work Order Status group. 

• Select the status indicator your want to assign from the drop down list. Available options 

include: 

o New Request 
o Waiting Approval 
o Waiting on Parts 
o Waiting on Labor 
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o Waiting on Production 
o Waiting on Contractor 
o On Hold (General) 
o Ready 
o In-Progress 
o Completed 
o Disapproved 

• Move to the % Completed field and to record this information. 
 

Work Order Costs 
This section allows you to record the costs associated with the selected work order, as shown in the 

following illustration. 

 

You record your information by moving to the various fields and clicking on the down arrow keys to 

access the attached calculators. Then edit the assigned values. These fields only accept numeric 

information. 

Calculate Costs 
The Calculate Costs feature performs the following functions: 

• It searches the assigned Material Resources database and then multiplies each assigned part 

with the Quantity Used by its unit price (Quantity Used X Unit Price). It then adds these values 

together to return a total Materials Costs. 

• If searches the assigned Labor Resources database and then multiples each assigned employee’s 

hourly rate by the hours worked (Hourly Rate X Hours Worked). It then adds these values 

together to return a total Labor Costs. 

• It takes the total values collected above and then adds them to the Contractors/Vendor field, 

Taxes/Permits field, and Other Costs fields, applying the result to the Total Costs field. 

To calculate the work order’s total costs 

• Record and edit the assigned Material Resources and Labor Resources databases. 

• From the Status tab of the Main Scheduler, move to the Work Order Costs group. 
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• Edit the Contractors/Vendor, Taxes/Permits and Other Costs fields with the values you want to 

assign. 

• Click on the Calculate Costs button. 

NOTE: When the Calculate Costs buttons is activated, the values assigned to the Material Costs, Labors 

Costs and Total Costs fields may be replaced with new values. 

Completion Notes and Delays 
Use the editor found in this area to record any information as it applies to completion notes and delays. 

You can also click on the Open with Editor button to edit this information with a text editor. 

 

Add New Work Order 
To add a new work order: 

 

• Move to the Main Scheduler. 

• Move to the Home tab in the ribbon and click on the Add New button. 

• When prompted about the operation, click on the response of your choice. 

o Yes – Launches the Work Order Wizard that steps you through the creation process. 

This wizard will be explained following the next section. 

o No – Creates a new work and returns you to the Main Scheduler where you can move 

through the various tabs editing and adding information as necessary. 

o Cancel – Backs out of the creation process. 
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Save Changes 
To save changes to the main work order record, click on the Post (✓ check) button in the Data Control 

located within the ribbon’s Quick Access toolbar. 

To save changes to the main work order record and all the underlying records (assets, attachments, 

etc.), click on the Save Changes button found on the Home tab of the ribbon control. 

Work Order Wizard 
The Work Order Wizard when accessed from the Main Scheduler will help ease in the work order 

creation process by stepping you through the process. This wizard is also accessible from the Work 

Orders Planner and the Work Orders Calendar where it is use to edit, or reschedule pre-existing work 

orders. 

The following illustration shows the general or shared features of the Wizard: 

   

• Tab Pages – This is a logical way of grouping controls by function. 

• Previous – Clicking this button moves you to the previous tab. 

• Next – Clicking this button moves you to the next available tab. 

• Save and Close – Clicking this button saves any changes you may have made, and closes the 

Wizard. 

• Cancel – Clicking this button closes the wizard without applying any changes made. 

Wizard Identification Tab 
The following illustration shows the elements on this tab: 
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• Subject – This is a brief description of the work order. It can contain up to 100 alpha/numeric 

characters. 

• Task ID – This is generated for you by the program. You are allowed to edit this value, but it is 

not recommended. 

• Check – This checks to ensure that the supplied Task ID is unique in the database. If it was 

generated by the program then is already known to be unique. 

• Location – This specifies the location at which the work order will be performed, and is 

selectable from the drop down list. 

• Task Type - There are 12 possible task types available, with 10 of these utilizing user definable 

titles. Five of these task types are designated as recurring types of work orders, where the 

others are designated as repair, or one-time work orders types. See the Work Orders Setup 

section in this chapter for more information.  Make your assignment by selecting the Task Type 

from the drop down list. 

Wizard Scheduling Tab 
The following illustration shows the elements on this tab: 

 

• Start Date – Selectable from the drop down calendar, this field represents the scheduled Start 

Date of the work order. 

• Start Time – Selectable from the drop down list, this field represents the scheduled Start Time 

of the work order. 
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• End Date – Selectable from the drop down calendar, this field represents the scheduled End 

Date of the work order. 

• End Time – Selectable from the drop down list, this field represents the scheduled End Time of 

the work order. 

Wizard Recurrence Tab 
The Recurrence tab only applies if the current task type has been assigned as one of the recurring types. 

If it is not a recurring task type, the features on this tab will be disabled. 

The following illustration shows the elements on this tab: 

 

• Recurring Frequency - This field allows you to specify the frequency at which the recurring work 

order will recreate (regenerate) itself. To setup the Frequency: 

o Click on the down arrow attached to this field. 

o Click on the value you want to assign from those listed. 

• XX Criteria - If the selected Recurring Frequency has XX anywhere in its description, the XX 

Criteria value must also be provided. To assign the XX Criteria value, please do the following: 

o Click the up or down arrows to increase or decrease the value here. 

• Generate New When Done - When this value is set, the program will not generate a new work 

order until the current work order is marked as completed. To set the Generate New When 

Done flag: 

o Place a checkmark in the Generate New When Done checkbox. 

Note about XX Criteria. The value entered here replaces the ‘XX’ criteria of the selected frequency. For 

example, if you have a Frequency of ‘Every XX Months’ selected, and you enter ‘5’ for the XX Criteria, the 

work order would regenerate ‘Every 5 Months’. 

Wizard Personnel Tab 
The following illustration shows the elements on this tab: 
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The Primary Work Assignment section allows you to assign 3 employees or mechanics to the current 

work order. These assignment show in the header section of work orders, and are also used with the 

Auto Work Order Email feature. 

To assign mechanics or employees to the work order: 

• Move to and click on the Select button adjacent to the Assignment field you want to assign an 

employee to. 

• From the invoked lookup dialog select the record you want to assign from those displayed. 

• Click on the Select button. 

• Repeat the above steps for each assignment you want to make. 

Wizard Assets Tab 
You can assign an unlimited number of assets to a work order. The following image illustrates the 

elements of this section: 

 

To assign an asset to the work order: 

• Move to the Assigned Assets section and click on the + (plus sign) in the data control found 

there. 

• From the invoked lookup dialog, click on the asset record you want to assign. 

• Click on the Select button. 
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Wizard Assignments Tab 
This section allows you make some general type assignment to your work order. These assignments help 

with the creation of reports. 

The following image illustrates the elements of this section: 

 

To make the assignments in this section: 

• Move to the appropriate field and click on the down arrow on the drop down list. 

• Make your selection by clicking on it. 

To assign a Requester: 

• Move to and click on the Select button adjacent to Requester field. 

• Select the employee you want to assign from the displayed grid, and then click on the Select 

button. 

Wizard Instructions Tab 
The options on this tab change somewhat by the type of work order currently in use. With recurring 

work order types you select work orders instructions from list of predefined instructions. Whereas, 

repair types of work order allow to type in your work instructions. 

The following illustration shows the elements for recurring types of work orders: 
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The following illustration shows the elements for repair types of work orders: 

 

To assign safety instruction to the work order 

• Move the Safety Instructions section and click on the Select button. 

• Select the instructions you want to assign from those listed, and click on the Select button. 

To assign work instructions for recurring work order types 

• Move the Work Instructions section and click on the Select button. 

• Select the instructions you want to assign from those listed, and click on the Select button. 

To include work instruction for repair types of work orders 

• Move to the Work Instructions section and edit your instructions in the editor found here. You 

can also click on the Edit button found in this area and use the Repair Procedures Editor 

discussed elsewhere in this chapter. 

Wizard – Save and Close 
Whenever you either make changes to work orders, or create a new one with Work Order Wizard, 

ensure to save your changes. 

• Click on the Save and Close button to save and apply your changes. 

Work Order Completion Wizard 
The Work Order Completion Wizard was designed to help with the process of completing a work order. 

The following illustration shows the general or shared features of the Wizard: 
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Ensure to click on the Save and Close button when done using this wizard to have your information 

saved back to the currently selected work order. 

Wizard – Resources Tab  
The following image illustrates the elements of this section: 

 

• Labor and Mechanics – Clicking on this button will launch the Work Order Labor dialog which 

allows you to record the employees and their associated times used in the work order 

completion. This feature is discussed in the Labor Resources section of this chapter.   

Wizard - Completion Notes Tab 
The following illustrates the elements of this section: 



PM Coordinator 

 

Simplicity Software Technologies Inc. | Work Order Completion Wizard 123 

 

 

Use the editor found here to record your completion notes or comments. Clicking on the Open with 

Editor button will allow you to record this information with the Text Editor. 

Wizard – General Tab 
The following illustrates the elements of this section: 

 

• Completion Date - Clicking on the down arrow here will expand the drop down calendar which 

will allow you to record the Completion Date of the work order. 

• Completed By – Click on the Select button adjacent to this field to invoke the Employees Lookup 

dialog. Select the employee you want to assign from the grid, and click Select. 

• Update Status to ‘Completed’ – Checking this option will have the wizard change the work 

order’s status to ‘Completed”. 

• Write summary to Equipment/Asset Log – Checking this option will have the wizard save a 

summary of the completed work order back to the Asset’s Log. 

• Update and Calculate Work Order Costs – Checking this option will update the work order’s 

costs information. Please refer to the Work Order Costs section of this chapter for more 

information. 

• Update Meter to show current value – Checking this option will have the wizard access the 

Assets database, read the Primary Asset’s current meter value, and then apply this to the 

current work order. 
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Completion Wizard – Save and Close 
Whenever you either make changes using the Work Order Completion Wizard, ensure to save your 

changes. 

• Click on the Save and Close button to save and apply your changes. 

Work Order Generation 
The Work Order Generation routines allows you to generate a group of work orders to be accessed 

together. Once generated you can then print selected work orders or print all the work orders found in 

this list. 

The following illustrates the elements of Generated Work Orders dialog.  

 

• Preview Selected – Clicking this button will provide a Print Preview of the selected work order. 

• Print Selected – Clicking this button will allow you to Print the selected work order. 

• Print All – Clicking this button will send every work order listed directly to the default printer. 

• Close – Closes the dialog. 

Generate Today 
This option will show all work orders with a scheduled start date of today. To use this option: 

• From the Main Scheduler, move to the ribbon control and select the Home tab. 

• Click on the Generate Today option. 
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Generate by Dates 
This option allows you to generate a date range of work orders. To use this option: 

• From the Main Scheduler, move to the ribbon control and select the Home tab. 

• Click on the Generate Options button to expand the drop down menu. 

• Click on the Generate by Dates option. 

• From the invoked Date Range dialog, setup the scheduled start and end dates of the work 

orders you want to view. Click Select button when done. 

Generate by Classification 
This option allows you to generate a date range of work orders belonging to a single classification 

assignment. To use this option: 

• From the Main Scheduler, move to the ribbon control and select the Home tab. 

• Click on the Generate Options button to expand the drop down menu. 

• Click on the Generate by Classification option. 

• From the invoked dialog screen setup the scheduled start and end dates of the work orders you 

want to view. 

• Move to the Select Classification group and click on the Select button found there. 

• Click on the classification you want to use from those listed and click on the Select button. 

• Click on the Select button from the setup dialog. 

Generate by Location 
This option allows you to generate a date range of work orders for a single location assignment. To use 

this option: 

• From the Main Scheduler, move to the ribbon control and select the Home tab. 

• Click on the Generate Options button to expand the drop down menu. 

• Click on the Generate by Location option. 

• From the invoked dialog screen setup the scheduled start and end dates of the work orders you 

want to view. 

• Move to the Select Location group and click on the Select button found there. 

• Click on the location you want to use from those listed and click on the Select button. 

• Click on the Select button from the setup dialog. 

Scheduling by Meter 
With the Maintenance Scheduler module you can have new recurring work orders regenerate by meters 

values. These meters can actually represent a variety of items such as hours, odometer readings, 

kilometers, cycles and more. This feature comes in handy for a variety of reasons such as scheduling 

equipment maintenance after so many hours or miles have past. 

To schedule by meter: 
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• From Main Scheduler, locate and select the work order you want to work with. 

• Move to the Details tab, and move the Work Order Settings section. 

• Ensure the work order is assigned one of the recurring Task Types. 

• Move to the Work Order Recurrence group, and select the Frequency of Every XX Meters. 

• Move to the XX Criteria field and edit this value. For example, say you have an automobile that 

you want to change the oil every 6,000 miles. You would enter 6000 here (no commas). 

• Next you need to setup the starting point for the commencement of the first work order. This 

step only needs to be completed once. On future work orders the XX Criteria information will be 

automatically applied.  

To setup when to perform the first work order 

• Move to and click on the Work Order page in the ribbon. 

• Click on the Recur option to expand the drop down. 

• Click on the Set Next Meter option. 

 

• Enter your numeric value (no commas) in the space provided, and click on the OK button. 

Generate New When Done 

The Generate New When Done flag is always set when scheduling by meters (the checkmark in the 

scheduler is ignored).  This is to say that the following criteria must be satisfied for an ‘Every XX Meters’ 

type of work orders to be able to regenerate: 

• An Equipment record or Asset is assigned to a work order. 

• The Equipment current meter is greater than zero. 

• The Recurring Frequency for the current work order must be setup to ‘Every XX Meters’. 

• A Value must be set for the XX Criteria. 

• The Set Next Meter has been set for the current work order. 

• The previous work order must be set as ‘Completed’. 

• The ‘Do Not Regenerate’ flag has NOT been set. 

Note: When a new work order is created, the new work order will have a scheduled start date 2 years 

in advance of the date it was created. This is to prevent the work order from showing up in the default 

filters, and from being reported as being past due. When the Equipment meter value reaches or 
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exceeds the Next Meter value the schedule start date will be changed to the date this information was 

first realized. 

When the new work order is generated: 

• The previous, completed work order will have its “Do Not Regenerate” flag set to true. This 

prevents the work order from regenerating itself multiple times. 

• The program will add the current equipment meter reading to the value as setup in the “XX 

Criteria” section, and use the resulting value to be met before the next work order becomes 

due. 

• The new task will have a scheduled start date of 2 years in advance from the date the new task 

was created. 

Editing Recurring Tasks 
The program is designed to allow users to create recurring work orders. These work orders regenerate 

themselves from previously created ones, copying all the fields and assignments of the previous work 

order to the new generated work order. Basically only the status and schedule dates are changed in the 

new work order (or next meter value, as the case may be). 

To change or delete a work order in the database, you need to find the work orders that have NOT yet 

regenerated themselves. Changing work orders that have yet to regenerate will affect only those work 

orders from that point forward. All previously generated work orders will not be affected. If you want to 

change works orders that have already regenerated, you will need to do this manually. 

Filter – Set to Regenerate 
To find all the work orders that are set to regenerate: 

• Open the Main Scheduler. 

• Move to the Filters page in the ribbon and click on the Set to Regenerate option. 
 

This will filter the database by all work orders that HAVE NOT regenerated. Deleting one of these work 

orders will prevent the program from regenerating it in the future. However, any previously regenerated 

work orders will remain in the database. You can also change the Do Not Regenerate flag to stop the 

work order from regenerating in the future. Also note that editing one of these work order will affect all 

work orders from that point forward. 

Change Do Not Regenerate flag. 
To toggle the Do Not Regenerate flag: 

• Locate the work order you wish to stop from regenerating. 

• Open the Work Orders tab in the ribbon and click on the Recur button to expand the drop down 
menu. 

• Click on the Change ‘Do Not Generate’ Flag option. 
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• When prompted about the operation, click on the Yes button.  

Changing work orders that have already regenerated. 
To change work orders that have already regenerated: 

• Locate the work order that has the same Subject or Description as the one you want to change. 

• Move to the Filters tab in the ribbon and click on the With Current Description option to expand 

the drop down. 

• Click on the filter option of your choice: 

o Show All Records – Shows every record in the database with the current description. 

o Open Records Only – This option shows all records yet to be completed. 

o Closed Records Only – This option shows all records that have been marked as 

completed. 

o Set to Regenerate – This option filters the database to show only those records that 

have not regenerated. 

You can edit these tasks with new dates or delete them from the database. Please note that if you edit a 

task that has already been regenerated (Do Not Regenerate flag checked) it will ONLY affect that task. 

Other, already created tasks or work orders will not be affected. 

Copy and Paste Work Order 
To copy a work order’s primary information to be pasted into a new or different work order: 

• Locate and select the work order you want to copy. 

• Move to the ribbon and click on the Work Orders tab. 

• Click on the Copy Work Order option. 

To paste a previously copied work order: 

•  Locate and select the work order you want to paste over. 

• Move to the ribbon and click on the Work Orders tab. 

• Click on the Paste Work Order option. 

Export the Current Work Order 
To export the current work order: 

• Locate and select the work order you want to export. 

• Open the File menu and select the Export Work Order option. 

• From the Export Work Order dialog box, move to the Save as type drop down and select the file 

type you want to save to. 

• Move to the File Name text box and enter the file name you want to use. 

• Click on the Save button.  
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The following export formats are supported: pdf, xlsx, xls, rtf, docx, htm, emf, tiff, png, jpg, gif, bmp and 

xps. 

Printing the Select Work Order 
To print the current work order: 

• Locate and select the work order you want to print. 

• Open the File menu and expand the Print menu by clicking on it. 

• Click on the Print Option of your choice: 

o Print Work Order - Allows printer selection and other options before printing. 

o Quick Print - Sends the document directly to the default printer 

• Print Preview - Provides a print preview of the current document 

Main Report – Filter Wizard 
The Main Reports – Filter Wizard is used for the Main Filter Wizard, Main Summary Report, Work 

Order Costs Report, Completion Summary Report and the Down Time Report. This wizard will be 

modified somewhat by its application, but it is setup basically the same no matter how used.   

When used for either filtering or reporting purposes, the resulting items will be returned by the choices 

or criteria as setup with this wizard. 

Types and Status tab 
The following illustrates the elements found on this tab: 

 

• Work Order Types – This drop down allows for the selection of the types of work orders to be 

included. Make your selection by clicking on an item in the drop down list. 
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• Work Order Status – This drop down allows for the selection of the work orders status indicator 

to be included. Make your selection by clicking on an item in the drop down list. 

With the Completion Summary Report, this tab is titled Status, and only the Work Order Status section 

is available. With both the Work Orders Costs and Down Time Reports, this tab is titled Task Types, and 

only the Work Order Types section is available. 

Assignments tab 
The following illustrates the elements found on this tab: 

 

• To assign values to these fields: 

o Move to the appropriate fields and click on the Select button adjacent to them. 

o From the invoked dialogs, move to the display grid and click on the record of your 

choice. 

o Click on the Select button.  

• To clear the assignments: 

o Move to the appropriate field and click on the Use All button adjacent to them. 

Dates and Sorting/Grouping tab 
The following illustrates the elements found on this tab: 
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To assign date values: 

• Move to the Start Date field and using the drop down calendar, select the starting date of your 

filtering criteria. 

• Move to the End Date field and using the drop down calendar, select the ending date of your 

filtering criteria. 

• To ignore or use all available dates, check the Use All Dates checkbox. 

• Next, if dates are used, move to the Date Types drop and select the type of dates you want your 

criteria based on. 

When using for the Main Summary Report or Custom Filter Wizard, move to the Order By section and 

select how you want your items sorted. 

 

When used for the other report options, move to the Group By area and select the Sorting option that 

describes how you want your items grouped. 

With everything setup as wanted, move to and click on the Accept button. 

Filtering Options 
To see information about filtering options, please refer the Ribbon Control – Filters Tab section of this 

chapter. 
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Work Orders Summary Report 
This report uses the Main Reports – Filter Wizard for the creation of report criteria.  Please refer to the 

Main Reports – Filter Wizard section of this chapter for more information. The only elements of this 

wizard that is not explained with this wizard is outlined next. 

These options are found on the Dates and Sorting tab of the wizard. 

• Include Task Instructions – When checked, the report will include all task instructions as 

assigned to each of the reported work orders. 

• Include Delays and Completion Comments – When checked, the report will include all Delays 

and Completions comments that were recorded for each of the reported work orders. 

To create a Work Orders Summary Report: 

• Move to the Reports tab in the ribbon.  

• Click on the Summary Report option. 

• Follow the instructions as outlined in the Main Reports – Filter Wizard section of this chapter.  

The following illustration shows a preview of a Work Orders Summary Report: 

 

Current Work Order Details Report 
 This report is based on the currently selected work order and will provide detailed information about 

the work order. This includes work order scheduling, assignments, materials list, total cost and more. 

To create a Work Order Details Report: 

• Locate and make current the work order you want to base your report on. 

• Move to the Reports tab in the ribbon and expand the Current W.O. options. 

• Click on the Work Order Details option. 
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Current Work Order Estimated Costs Report 
This report gives you a printout of the cost information associated with the currently selected work 

order. 

To create a Current Work Order Estimated Costs Report: 

• Locate and make current the work order you want to base your report on. 

• Move to the Reports tab in the ribbon and expand the Current W.O. option. 

• Click on the Estimated Costs option. 

Completed Work Orders Costs Report 
This report gives you a printout of the cost information associated with the work orders with a status 

indicator of ‘Completed’. 

To create the Completed Work Orders Costs report: 

• Move to the Reports tab in the ribbon and expand the Completed WOs option. 

• Click on the Work Orders Costs option. 

• Follow the instructions as outlined in the Main Reports – Filter Wizard section of this chapter.  

Completed Down Time Wizard Report 
The Down Time Wizard Report allows you to run a report on a machine or machines down time. This 

report allows you to specify date ranges and other criteria for some fairly custom reporting. 

To create the Down Time Wizard report: 

• Move to the Reports tab in the ribbon and expand the Completed WOs option. 

• Click on the Down Time Wizard option. 

• Follow the instructions as outlined in the Main Reports – Filter Wizard section of this chapter.  

Completion Analysis Report 
The Completion Analysis Reports look at all work orders that are completed in a given time date range, 

and then breaks down this information as to the total number of different work orders types that were 

completed, and the percentage of these types that where completed on time or late. 

To create the Completion Analysis report: 
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• Move to the Reports tab in the ribbon and expand the Completed WOs option. 

• Click on the Completion Analysis option. 

• Setup the Start Date and End Date for your report date range and click on the Select button. 

Repair Codes Report 
The Repair Codes Report allows you to create a report based on a single piece of equipment, either one 

or all repair codes for that equipment’s work orders, and a date range you specify. Please refer to the 

Work Order Repair Code section of this chapter to see possible benefits of using repair codes. 

 

To create a Work Repair Codes Report: 
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• Move to the Reports tab in the ribbon and expand the Completed WOs option. 

• Click on the Repair Codes option. 

• Click on the Select button in the Equipment Assignment Selection group. 

• Click on the equipment you want to base your report on from those listed and click on the Select 

button. 

• Click on the Select button in the Repair Code Selection group. 

• Click on the repair code you want to base your report on from those listed and click on the 

Select button. 

• To use all codes insure that the Include All Codes checkbox is checked. 

• Setup the Start Date and End Date for your report date range. 

• To use all dates insure that Include All Dates checkbox is checked. 

• Click on the Accept button to run the report. 

Equipment Summary Report 
The Equipment Summary Report groups the report by equipment and then gives totals for the following: 

• Labor Hours 

• Labor Costs 

• Material Costs 

• Other Costs 

• Total Costs 

• Total number of Work Orders Performed 

• Total Downtime. 

To create the Equipment Summary Report: 

• Move to the Reports tab in the ribbon and expand the Summary Reports option. 

• Click on the Equipment Summary option. 

• Follow the instructions as outlined in the Main Reports – Filter Wizard section of this chapter.  

Completion Summary Report 
The Completion Summary Report groups the report by dates and then reports on the following: 

 

• Date Completed 

• Asset Information 

• Work Order Subject 

• Labor Hours 
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• Downtime 

• Total Costs 

• On-Time  

To create a Completion Summary Report: 

• Move to the Reports tab in the ribbon and expand the Summary Reports option. 

• Click on the Completion Summary option. 

• Follow the instructions as outlined in the Main Reports – Filter Wizard section of this chapter.  

Open Work Orders By Mechanic Report 
The Open Work Orders by Mechanic Report allows you create a report on all open work orders for a 

given mechanic or employee. 

To create an Open Work Orders by Mechanics Report: 

• Move to the Reports tab in the ribbon and expand the Labor Resources option. 

• Click on the Open by Mechanic option. 

• From the invoked Employees Database dialog, select the employee you want to base your 

report on from those listed in the grid. 

• Click on the Select button. 

Closed Work Orders By Mechanic Report 
The Closed Work Orders by Mechanic Report allows you create a report on all closed work orders for a 

given mechanic or employee. 

To create a Closed Work Orders by Mechanics Report: 

• Move to the Reports tab in the ribbon and expand the Labor Resources option. 

• Click on the Closed by Mechanic option. 

• From the invoked Employees Database dialog, select the employee you want to base your 

report on from those listed in the grid. 

• Click on the Select button. 

Overdue Work Orders By Mechanic Report 
The Overdue Work Orders by Mechanic Report allows you create a report on all overdue work orders 

for a given mechanic or employee. 

To create an Overdue Work Orders by Mechanics Report: 

• Move to the Reports tab in the ribbon and expand the Labor Resources option. 
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• Click on the Overdue by Mechanic option. 

• From the invoked Employees Database dialog, select the employee you want to base your 

report on from those listed in the grid. 

• Click on the Select button. 

Man Hours Report Wizard 
The Man Hours Report Wizard is used with both the Projected Man Hours and Actual Man Hours 

reports. 

The following illustrates the elements found on this wizard: 

  

• Start Date – This field indicates the Starting Date of the report’s date range. Select from the 

drop down calendar. 

• End Date – This field indicates the Ending Date of the report’s date range. Select from the drop 

down calendar. 

• Use All Dates – Check this option to ignore any assigned dates. 

• Mechanic Assignment Selection - Click on the Select button here to base your report on a 

specific employee assignment. 

• Use All Mechanics – Check this option to ignore the mechanic assignment, and use all 

assignments.  

• Asset – Equipment Selection - Click on the Select button here to base your report on a specific 

asset assignment. 
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• Use All Assets – Check this option to ignore the asset assignment, and use all assignments.  

• Accept – Clicking this button accepts the report criteria as configured. 

Projected Man Hours Report 
The Projected Man Hours Report will return information on open work orders, and the projected man 

hours assigned for their completion. 

 

To create the Projected Man Hours Report: 

• Move to the Reports tab in the ribbon and expand the Labor Time option. 

• Click on the Projected Man Hours option. 

• Follow the instructions as outlined in the Man Hours Report Wizard section of this chapter.  

Actual Man Hours Report 
The Actual Man Hours Report will return information on closed work orders, and the man hours actually 

used and recorded for their completion.  

To create the Actual Man Hours Report: 

• Move to the Reports tab in the ribbon and expand the Labor Time option. 

• Click on the Actual Man Hours option. 

• Follow the instructions as outlined in the Man Hours Report Wizard section of this chapter.  

Open Work Orders by Primary Asset Report 
This reports displays information on all open work orders for a given Primary Asset. 

To create an Open Work Orders by Primary Asset Report: 

• Move to the Reports tab in the ribbon and expand the Open WOs option. 
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• Click on the Open by Primary Asset option. 

• From the invoked Equipment and Assets dialog, move to the grid and click on the record of your 

choice. Your report will be based on this selection. 

• Click on the Select button. 

Projected Costs Report 
This report returns information of the Projected Costs of work orders. 

 

To create the Projected Costs Report: 

• Move to the Reports tab in the ribbon and expand the Open WOs option. 

• Click on the Open by Primary Asset option. 

• Follow the instructions as outlined in the Main Reports – Filter Wizard section of this chapter.  

Past Due Work Orders Report 
This report returns information on all work orders that have scheduled completion prior to today’s date. 

To create the Past Due Work Orders Report: 

• Move to the Reports tab in the ribbon and expand the Open WOs option. 

• Click on the Past Due Work Orders option. 

Open Work Requests Report 
This report returns information on work orders that still have a status of ‘Work Request’. 
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To create the Open Work Request Report: 

• Move to the Reports tab in the ribbon and expand the Open WOs option. 

• Click on the Open Work Requests option. 

Repair Procedures Editor 
The Repair Procedures Editor is used to create and modify various work order related documents and 

instructions. One of the key advantages of using this editor as compared to our other editor is that you 

can build a database of repair related procedures, and reuse them for easy insertion. 

The following illustrates the layout of the Repair Procedures Editor: 

  

With the exception of the ribbon’s Editor tab, this editor employs many of the same features of the 

word processor we use throughout the application. Because it has so many shared features, we would 

like to refer you to the chapter on the Rich Text Editor to learn how to use these shared features. 

Editor Ribbon Control 
The Repair Procedures Editor has its own ribbon control, and like the other ribbons found in the system, 

this ribbon has its available options arranged in logical groups. 

The following illustration shows the Editor’s ribbon: 
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The following are the elements on the Editor ribbon tab, reading left to right: 

• Save and Close - Saves the current document back to the call-up control and closes the editor. 

• Paste – Inserts any clipboard text into the document, and at the current cursor location. 

• Cut – Deletes selected text and places it into the clipboard. 

• Copy – Copies selected text and places it into the clipboard. 

• Set Next Number -Sets the next number to be used in the Instructions – Numbered bullet list. 

• Reset to One -Sets the next number to One in the Instructions - Numbered bullet list. 

• Toggle Instructions Bullets -Turns instruction bullets either on or off. 

• Numbers + Brackets -Turns on the Instructions type Numbers, Check-off bracket style bullets. 

• Check-Off Brackets - Turns on the Instructions type Check-off bracket style bullets. 

• Bullets - Start a bulleted list (non-instruction type). 

• Numbering - Start a numbered list (non-instruction type). 

• Decrease Indent - Decrease the indent level of the paragraph. 

• Increase Indent - Increase the indent level of the paragraph. 

• Find - Find text in the document. 

• Replace - Replace text in the document. 

• Spelling - Checks the document for spelling errors. 

• Cancel and Close – Closes the editor without applying any changes. 

For the elements on the remaining ribbon tab pages, please refer to the Rich Text Editor chapter.  

Editing Your Document 
To edit your document with this editor, simply move to the main editor and begin the editing process. 

This editor supports many formatting options and uses the Rich Text Format (RTF). Some of your 

formatting options will be discussed here.  However, the majority of the available options for this editor 

will be discussed in detail in the Rich Text Editor chapter. 

Using Instructions Bullets 
When editing work order instructions using this editor, you may want to include bullets lists, lists with 

check off boxes and numbered lists with check off boxes.   

To use Instruction bullets: 
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• Move to the ribbon control and click the bullet type of your choice. The top roll of options in the 

Bullet group deals with instruction type bullets. 

• Click in the editor where you want to begin using bullets. 

• Press the Enter key to both start a new line, and insert the selected bullet style. 

• Repeat clicking Enter after each line to continue the bullets insertion. 

To stop the use of the bullets: 

• Move to the ribbon and click on the Toggle Instruction Bullets option. 

Find 
To search for every occurrence of a specific word or phrase: 

• Click the Find button on the Editing toolbar or press CTRL+F. 

• From the invoked Find and Replace dialog, move to the Find what box and type in the text to 

search for. 

• Select other search options that you want and click Find Next. 

• To cancel a search, click Cancel or press ESC.  

Find and Replace Text  
To automatically replace text: 

• Click the Replace button on the Editing toolbar or press CTRL+H. 

• From the invoked Find and Replace dialog, move to the Find what box and type in the text to 

Replace. 

• Select other search options that you want and click Find Next, Replace or Replace All. 

For more information on the Find and Replace features, please refer the Rich Text Editor chapter. 

Working with the Procedures Database 
The Procedures Database part of the Repair Procedures Editor allows you to create a database of 

common tasks procedures. These procedures would be reusable, and could relate to both repair and 

recurring work order types. 

Please note that this editor allows the use of reusable tasks instructions. This does not mean you are 

required to use these reusable instructions in every case. It is perfectly acceptable, and in most cases 

advised to type in instructions directly into the document as needed.  

Using the Documents Tree 
To find how to use the Documents Tree found here, please refer to the Document Trees section of the 

Common Features chapter. Most of the options dealing with this tree are accessible by right mouse 

clicking from within the tree. 
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The following illustrates the popup menu that is accessible by right mouse clicking on various elements 

of the Documents Tree. 

 

Add New Procedure to the Database 
To add a new procedure to the database: 

• Move to the Documents Tree and right mouse click on the folder you want to assign the new 

procedure to. 

• From the invoke popup menu select the Add Procedure option. 

  

• From the invoked Edit Procedure dialog, move to and click in the Task Description text box. 

• Enter a descriptive title in the box provided. This Task Description can contain up to 40 

alpha/numeric characters. 

• Move to the Tasks to Perform text box and enter the actual procedure to store. There is no size 

limitation to the field. 
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• When done editing your new procedure, click on the Accept button. 

Editing an Existing Procedure 
To edit an Existing Procedure: 

• Move to the Procedures Tree and right mouse click on the procedure you want to edit. 

• From the invoked popup menu, click on the Edit Procedure option. 

• Edit the Procedure is the same manner that it was created, clicking the Accept button when 

done. 

Inserting Existing Procedures into the Document 
The whole purpose of having a database of repair procedures is to be able to quickly reuse them in your 

documents. To insert a saved procedure into the current document: 

• Click in your document where you would like the insertion to occur. 

• Move to the Document Tree and select the document or procedure you want to insert. 

• Move to the Insertion Options drop down and select the formatting option you want to apply to 

the procedure insertion. Available options include: 

o Text Only 

o Check Off Brackets 

o Numbers and Brackets 

• Move to and click on the Insert (arrow) button (double clicking also works). 

• Repeat the above procedures for each insertion. 

Procedures Editor – Save and Close 
Whenever you either make changes using the Repair Procedures Editor, ensure to save your changes. 

• Click on the Save and Close button to save and apply your changes. 

Creating a PM (Recurring) Work Order with Creation Wizard 
This tutorial will outline the steps to follow in the creation of a recurring (PM) work order using the 

creation wizard. 

1. Move to the ribbon and click on the Add New option. 
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2. When prompt about using the Wizard, click YES. 

 
3. From the invoked Work Order Wizard, move to the Identification tab. 

  
4. Click in the Subject text box and type in an identifying description of the work to be performed. 

5. Click in the Task ID field and edit this information.  

The program will generate this ID for you and does not require modification. To check to see if 

the ID you supply is unique in the database, click on the Check button. 

6. To assign a Location to the work order, click on the down arrow attached to the drop down list 

and select on the option of your choice. 

7. Next you need to assign the work order a ‘Recurring’ task type. This is done by selecting an 

option from the Task Type drop down list. 

 
There are 12 possible task types available, with 10 of these having user definable titles. Five of 

these task types are designated as recurring types of work orders, where the others are 
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designated as repair, or one-time work orders types. See the Work Orders Setup section in this 

chapter for more information.  

8. Click on the Next button to move to the Scheduling tab. 

This tab allows you to specify the scheduling for the new work order. 

 
9. Move to both the Start Date and End Date fields and use the attached calendars to set when 

you expect work to begin and end on this work order. 

10. Move to both the Start Time and End Time fields and using the attached drop down list, setup 

the values you want to assign. 

11. Click on the Next button to move to the Recurrence tab. 

This tab is only available when one of the recurring task types is assigned on the Identification 

tab. 

 
12. Move to Recurring Frequency drop down and select a recurring frequency for this work order. 

13. If the selected Frequency has XX anywhere in its description, the XX Criteria value must also be 

provided. Set this value by typing in a numeric value in the space provided. You can also use the 

attached drop down calculator to set the value. 

The value entered here replaces the ‘XX’ criteria of the selected frequency. For example, if you 

have a Frequency of ‘Every XX Meters’ selected, and you enter ‘3000’ for the XX Criteria, the 

work order would regenerate ‘Every 3000 Meters’. 

14. Check the Generate New When Done checkbox if you would like regeneration to occur only 

when the work order is marked as completed. If left uncheck, the work order will regenerate at 
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the assigned frequency regardless of task completion. 

For more information look at the Generate New When Done section of this chapter. 

15. Click on the Next button to move to the Personnel tab. 

This tab allows you to assign personnel or mechanics to the work order.  

 
16. Move the Assignment 1 area and click on the Select button found there. This will allow you to 

assign an employee to the work order. 

17. From the invoked Employees Database dialog, move to the grid and select the employee you 

want to use for this assignment. Click on the Select button. 

 
18. Optionally repeat the above step for the other two assignments. 
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19. Click on the Next button to move to the Assets tab. 

This tab allows you to assign equipment or assets to the work order. 

 
20. To add an Equipment or Asset assignment to the Work Order, locate the data control and click 

on the Append (+) button. 

21. From the invoked Equipment and Assets dialog, move to the grid and select the record you 

want to assign. Click on the Select button. 

 
22. Optionally repeat adding assets as just outlined until all required assets have been included. 
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23. Click on the Next button to move to the Assignments tab. 

This tab allows you to make general assignments to the work order. 

 
24. Move to the Classification drop down and select an assignment you want to use. 

Classifications are used to help group things for easier lookups and for reporting purposes.  

25. Move to the Account drop down and select an assignment you want to use. 

26. Move to the Requester field and type in the name of the person requesting this work to be 

performed. You can also select an employee by clicking on the Select button found here. 

27. From the invoked Employees Database dialog, move to the grid and select the employee you 

want to use for this assignment. Click on the Select button. 
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28. Move to the Requester Email text box, and if not already inserted for you using the previous 

step, type in this information. 

29. Click on the Next button to move to the Instructions tab. 

This tab will change depending if the work order task type is a one-time, or recurring work 

order. 

 
30. Move to the Safety Instructions group and click on the Select button to assign a set of 

predefined safety instructions from instructions database. 

31. From the invoked Instructions Lookup dialog, select the instructions you want to assigned from 

within the grid, and then click on the Select button. 

 
32. For recurring work orders continue next, else skip to step 36 

33. Move to the Work Instruction group and click on the Append (+) button in the data control. 

34. From the invoked Instructions Lookup dialog, select the instructions you want to assigned from 

within the grid, and then click on the Select button. 
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35. Repeat the above step for each set of instructions you want to assign. 
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Work Orders Planner 

With the Work Order Planner option you can display and print the maintenance schedule for an entire 

month, create and edit existing work orders, export a copy of the planner to Excel and more. 

 

To access the Work Order Planner: 

• Move to the Outlook styled – Navigational bar located on the left side of the screen. 

• Click on the large group button with the caption: Work Order Planner. 

Or 

• From the Main Scheduler, move to the Go tab in the ribbon. 

• Locate the Work Orders group and click on the Planner option. 

WO Planner – Ribbon 
The Work Order Planner has its own ribbon control, and like the other ribbons found in the system, this 

ribbon has its available options arranged in logical groups. 

The following illustration shows the Planner’s ribbon: 
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 The following are the elements on the View Navigation ribbon tab, reading left to right: 

• Backward – This button moves the planner backwards in time, one month per click. 

• Forward – This button moves the planner forward in time, one month per click. 

• Today – Clicking this button moves you to the current month. 

• Zoom In – Clicking this button zooms in on the current view. 

• Zoom Out – Clicking this button zooms out on the current view. 

• Add New – Invokes the Work Order Wizard that will allow you to create a new work order. 

Please refer to the Work Order Wizard section of this chapter on to use this wizard. 

• Print Work Order – When a work order is selected, this option will provide a ‘Print Preview’ of 

the selected work order. 

• Edit Work Order – When a work order is selected, this option will allow you to edit the selected 

work order with the Work Order Wizard. 

• All Work Orders – Clicking this option will filter the Planner by all work orders assigned to the 

current month. 

• Single Asset – Clicking this option will allow to select a single asset to filter the Planner’s work 

orders by. To use this option: 

o Click on the Single Asset button to invoke the Equipment and Assets lookup dialog. 

o Move to the grid and select the record you want to filter by and click the Select button. 

• Single Mechanic – Clicking this option will allow to select a single employee assignment to filter 

the Planner’s work orders by. To use this option: 

o Click on the Single Mechanic button to invoke the Employees Database lookup dialog. 

o Move to the grid and select the record you want to filter by and click the Select button. 

• Single Classification– Clicking this option will allow you to select a single classification 

assignment to filter the Planner’s work orders by. To use this option: 

o Click on the Single Classification button to invoke the lookup dialog. 

o Move to the grid and select the record you want to filter by and click the Select button. 

• Single Location– Clicking this option will allow you to select a single location assignment to filter 

the Planner’s work orders by. To use this option: 

o Click on the Single Location button to invoke the lookup dialog. 

o Move to the grid and select the record you want to filter by and click the Select button. 

Planner - Editing a Work Order 
To edit a work order from within the Planner: 
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• Double click on the work order you want to edit, or click on the work order to select it and then 

click on the Edit Work Order option in the ribbon. 

• Please refer to the Work Order Wizard section in this chapter on how to use the invoked wizard. 

Planner - Printing a Work Order 
To print a work order from the Planner: 

• Select the work order from those displayed in the Work Order Planner. 

• Click on the Print Work Order option in the ribbon. 

Printing the Work Order Planner 
To print the Work Order Planner’s current view: 

 

• Select the Month that you want to print. 

• Open the File menu and expand the Print Options sub-menu. 

• Click on the Print option of your choice. 

Exporting the Work Order Planner 
To export the current Work Order Planner view: 

• Select the Month that you want to export. 

• Open the File menu and expand the Export Options sub-menu. 

• Click on the Export option of your choice. Available options include: 

o Export to Excel 

o Export to PDF 

o Export to HTML 
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Navigating through The Work Order Planner 
There are couple of different ways to navigate through the months of the Work Order Planner. 

Navigating with the ribbon control 

To navigate through the Work Order Planner using the ribbon control: 

• Backward – This button moves the planner backwards in time, one month per click. 

• Forward – This button moves the planner forward in time, one month per click. 

• Today – Clicking this button moves you to the current month. 

Navigating with the Shortcut bar’s Calendar 

You can use the Calendar located in the Shortcut bar to navigate through the months of the Work Order 

Planner. 

The following illustrates the main elements of this calendar: 

 

Clicking on any date within this calendar will have the Work Order Planner move to the selected month. 
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Equipment and Assets 

The Equipment and Assets module is where you record information about your equipment, machinery 

and other assets. You can maintain information such as asset numbers, location, warranty information, 

leasing information, and more.  

The built in equipment notes and documents feature makes use of our built in word processor. Here you 

can record endless amounts of information and this word processor supports multiple fonts, colors, 

tables and more. With the History Log feature you can keep a complete maintenance history on your 

assets. This can include the date it was installed, maintenance performed, etc. This information can be 

entered manually, or by the click of a button from the Maintenance Scheduler, Work Orders and Issues 

modules.  

 

Equipment can also be assigned to different properties or locations. This information can be set to 

follow the asset when assigned to work orders. You can also setup default safety instructions for each of 

your assets. This information can then be automatically inserted into work orders when the equipment 

is assigned to the work order.  

Ribbon Control 
The comprehensive functionality of the Equipment and Assets module is provided via a set of Ribbon 

tabbed pages. Ribbon pages are structurally and visually split into logical groups. Each of these groups 

includes commands that perform specific functions. 
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HOME TAB 

 

The following are the elements on the Home ribbon tab, reading left to right: 

• Add New – Creates a new blank record in the database. 

• Save Changes – Saves all current changes from all elements of a record (master save). 

• Collection Sheet – Prints a meters collection sheet returning all assets that has the Use Meters 

option selected. 

• Enter Meters – Invokes the Enter Meter Readings dialog that allows you to enter meter 

readings for multiple assets at once. 

• Primary Asset’s Notes – Uses the built-in word processor to maintain detailed notes on each 

asset. 

• Assigned Work Orders – Allows the viewing and printing of open work orders assigned to the 

current asset. 

• Copy Asset Record – Makes a copy of the primary fields of the selected record. 

• Paste Record – Pastes a previous copied record over the current record. 

• Search - Invokes the search/find routine on the Lookup Grid. 

• Exit Module - Close and exits the module. 

FILTERS TAB 

 

The following are the elements on the Filters ribbon tab, reading left to right: 

• Default Filter – Shows every record in the database. 

• Filter Wizard - Launches the Custom Filter Wizard dialog that allows specific criteria to be setup 

to filter the database by. 

• Use Meters - Shows all assets that have the Use Meters option selected. 

• Selected Records - Shows all assets that have the 'Selected' option checked. 
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ASSET TAB 

 

The following are the elements on the Asset ribbon tab, reading left to right: 

• Default Safety Instructions - Allows you to assign the default safety instructions to use in the 

creation of new work orders and for the current asset. 

• Property Assignment – Allows you to assign the current asset to a specific property. 

REPORTS TAB 

 

The following are the elements on the Reports ribbon tab, reading left to right: 

• Report Wizard – Invokes the Report Wizard to help in the creation of a report. 

• Assigned Work Orders – Invokes a wizard in the creation of an assigned work orders 

report. 

• History Log – Prints a date range of log entries as it applies to the current asset. 

• Property Information – Print information on the assigned property. 

• Predictive Maintenance – Uses a wizard in the creation of a predictive maintenance 

worksheet type report. 

Lookup Tab 
This tab helps in locating assets by grouping, filtering and sorting them. All the assets in the current filter 

are located in the grid found here. To select an asset and make it the active record, the user needs only 

to click on the asset from within the grid. Once selected the user can click on the other tabs to view or 

edit the asset itself. 

The following image illustrates the features available on the Lookup tab: 
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The functions of the Lookup tabs are used through-out the system and are fairly common regardless of 

the modules that use them. Please review the chapter on Common Features to read about the 

functionality of the controls located on this tab.  

Details Tab 
Under the Details tab you can setup your identification information, and general assignments for 

selected assets. 

Identification 
This section allows you to specify a description, reference ID, manufacturer and other general 

information specific to the current asset. 

The following illustrates the elements found in this section: 

 

Reference ID 
This field should be unique in your database, but it’s not an enforced rule. It is used to help identify your 

assets, and is also used in conjunction with barcode scans. Edit this field by typing in the space provided. 

This field can accept up to 30 alpha/numeric characters. 

Once the Description field has been entered you can click on the Auto button to have the application 

create this field for you. 

To insure the Reference ID is unique in the database, click on the Check button. 
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Description 
This field should provide a brief description of the asset. This field can contain up to 60 alpha/numeric 

characters. 

Manufacturer 
This field can contain up to 40 alpha/numeric characters and is used to indicate the manufacturer of the 

asset. 

Model No 
This field can contain up to 30 alpha/numeric characters and is used to indicate the manufacturer’s 

model number. 

Asset No 
This field can contain up to 30 alpha/numeric characters and is used to indicate the accounting asset 

number. It would be acceptable to interchange this and the reference number fields. 

Serial No 
This field can contain up to 40 alpha/numeric characters and is used to indicate the manufacturers 

supplied serial number. 

In-Service 
When checked, this field would indicate the asset is currently in use. 

Selected 
When checked, this field would indicate the asset is selected. This is used with filtering and for barcode 

label printing routines. 

General 
This section allows you to record general information about the current asset. 

The following illustrates the elements found in this section: 
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Meter Value 
If the current asset uses meters such as mileage, hours, etc., you will want to record this value here. This 

field accepts numeric values only, and does not support the use of commas. You can use the drop down 

calculator to edit this value. There are also other areas of the application that can be used to edit this 

value. 

Use Meters 
When checked, this would indicate that the current asset uses meters. This will allow the asset to show 

up in meter collection routines and reports. 

Meter Type 
Selectable from the drop down list, this field indicates the type of meter in use. 

Service Date 
This date field would indicate the date the asset was put in-service. You can set this date with the drop-

down calendar. 

Safety Instructions 
This is the default safety instructions that will be assigned to new work orders as this asset is added to 

them. To assign these default instructions: 

• Click on the Lookup button adjacent to this field. 

• From the invoked list, click on the instructions you want to assign from those displayed in the 

grid and click on the Select button. 

Note: These instructions are created in the Maintenance Scheduler module. 

Vendor 
This field is used to identify the primary vendor for this record. This field can contain up to 40 

alpha/numeric characters. 

Special Field 
This is a special field that you can record whatever information you want. This field can contain up to 30 

alpha/numeric characters. 

Assignments 
Assignment can be used for both filtering and report creation. 

The following illustrates the elements found in this section: 
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Classification 
Classifications are used throughout the system and are ideal for grouping things for filtering and 

reporting purposes. This field can contain up to 30 alpha/numeric characters. You can assign this field by 

selecting from the drop down list, clicking the Manage button, or typing in to the field. 

Account 
Accounts are used throughout the system and are ideal for grouping things for filtering and reporting 

purposes. This field can contain up to 30 alpha/numeric characters. You can assign this field by selecting 

from the drop down list, clicking the Manage button, or typing in to the field. 

Assigned To 
The Assigned To field is used in a similar way as the two fields above. This field can contain up to 40 

alpha/numeric characters. You can type directly into this field or select an employee from a list. To 

select from a list: 

• Click on the Lookup button adjacent to this field. 

• From the invoked list, click on the record you want to assign from those displayed in the grid 

and click on the Select button. 

Location 
This section allows you to specify the asset’s location. This feature can be used separately, or used in 

conjunction with Property Assignments features. 

The following illustrates the elements found in this section: 

 

All three of these fields can be set from the down drop lists attached to them, or you can type directly 

into these fields. These fields can contain up to 30 alpha/numeric characters. 
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Ownership – Leasing 
This section allows you to record asset ownership information and leasing information that may apply. 

The following illustrates the elements found in this section: 

 

Ownership 
Selectable from the drop down list, this field indicated asset ownership. Options include: Company 

Owned, Client Owned and Leased. 

Company 
This field can contain up to 40 alpha/numeric characters, and can be directly typed or selected from the 

drop down list. 

Lease Start – Lease End Dates 
These are date only fields, and can be set by accessing the attached drop down calendars. 

Warranty Information 
This section allows you to maintain any warranty information that may apply to the selected asset. 

The following illustrates the elements found in this section: 

 

Warranty Start – Warranty End Dates 
These are date only fields, and can be set by accessing the attached drop down calendars. 



PM Coordinator 

 

Simplicity Software Technologies Inc. | Options Tab 164 

 

Warranty Info 
Use this field to record any warranty related information about the current asset. This field has no built-

in size limitation and can contain alpha and numeric characters. 

Options Tab 
Under the Options tab you can setup general assignments for selected assets, and other more advanced 

options are available. 

Special Fields 
This section allows you to create and use Special Fields. Special Fields can be thought of as groups of 

User Defined Fields. Each group can have a Group Name and 8 fields with user defined titles. 

The following illustrates the elements found in this section: 

 

For more information about this feature please refer to the Special Fields section of the Common 

Features chapter. 

Manage Selected Special Fields 
To setup the titles for the current set of special fields: 

• Select the Special Fields group as found on the Options tab and within the grid. 

• Open the File menu and expand the Manage Special Fields sub menu. 

• Click on the Manage Selected Fields option. 

The Equipment and Assets module has an additional feature not discussed in the Common Features 

chapter, and this is Pre-Defined set of fields. To use the Pre-defined fields: 

• From the Asset’s User Defined Fields dialog, move to the Pre-Defined Fields drop down list and 

select the pre-defined group of your choice. 

• Click the Set Fields button. 

WARNING: The above action will overwrite the existing user titles. 

For more information about this feature please refer to the Special Fields section of the Common 

Features chapter. 
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Asset Disposition 
This section allows you to record information about assets that are no longer in use. 

The following illustrates the elements found in this section: 

 

Current Status 
This option can be set from the drop down list. Available options include: In Use, Disposed, 

Sold/Scraped. 

Date Disposed 
This date field would indicate the date the asset was taken out of service. You can set this date with the 

drop-down calendar. 

Sales Price 
This field would indicate any monies collected in the disposable of the asset.  

Linked Assets 
You can link an asset record to a countless number of other assets. This comes in handy for parent/sub-

assembly support where you can also mark the record as a sub-assembly, and then link it to a parent 

record. You can also reverse this role and link parent records to their subordinates. 

The following illustrates the elements found in this section: 

 

To add Linked Assets 

• Move to the Options tab of the assets database, and then click on the Linked Assets tab near 

the bottom. 

• Move to the data control found in the Linked Assets group and click on the Append (+) button. 

• From the invoked Lookup dialog, move to the grid and select the record you want to link to. 



PM Coordinator 

 

Simplicity Software Technologies Inc. | Linked Assets 166 

 

• Click on the Select button. 

• Click on the Post (checkmark) button in the data control to save your changes. 

To delete a Link 

• Move to the Options tab of the assets database, and then click on the Linked Assets tab near 

the bottom. 

• Move to the Linked Assets grid and select the record you want to remove. 

• Move to the data control found in the Linked Assets group and click on the Delete (-) button. 

 

• When prompted about the deletion, click on the Yes button. 

• Click on the Post (checkmark) button in the data control to save your changes. 

To open a link and move focus to that record 

• Move to the Options tab of the assets database, and then click on the Linked Assets tab near 

the bottom. 

• Move to the Linked Assets grid and select the record you want branch to. 

• Click on the Open Asset button. 

To set the Parent Asset 

• Move to the Options tab of the assets database, and then click on the Linked Assets tab near 

the bottom. 

• Move to the Parent Asset group and click on the Select Parent Asset button. 

• From the invoked Lookup dialog, move to the grid and select the record you want to link to. 

• Click on the Select button. 

To open the Parent Asset Record 
• Move to the Options tab of the assets database, and then click on the Linked Assets tab near 

the bottom. 

• Move to the Parent Asset group and click on the Open Parent Asset button. 

To set the current asset as a Sub-Assembly 
• Move to the Options tab of the assets database, and then click on the Linked Assets tab near 

the bottom. 
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• Check the ‘This is a Sub-Assembly to the Above Asset’ checkbox. 

Attached Documents 
You can attach as many external files as you would like to a record. These attachments can include 

images, mechanical drawings, PDF files, MSDS sheets and more. For more information on this feature, 

please refer to the Attachments section of the Common Features chapter. 

The following illustrates the elements found in this section: 

 

To access the attachments: 

• Move to the Options tab of the assets database, and then click on the Attached Documents tab 

near the bottom. 

Asset’s Picture 
It is recommended to use file attachments for pictures, but you can also save a picture directly in the 

database. The reason attachments are recommended is because they use a lot less database space as 

compared to imbedded pictures. 

To access the asset’s picture: 

• Move to the Options tab of the assets database, and then click on the Picture - Vehicle tab near 

the bottom. 

The following illustrates the elements found in this section: 
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To set the Image 

• Click on the Set Image button. 

• Using the invoked file open type dialog, browse to where you have your image stored. The 

following formats are supported: bmp, gif, jpg, ico, and png. 

• Select the image file by clicking on it and then click the Open button. 

To export the stored Image 

• Click on the Export Image button. 

• Browse to where you want to save the file. 

• Type in a name for your file in the File name text box. 

• Move to the Save as type drop down list and select the file type to save as. 

• Click on the Save button. 

To view the stored Picture 

• Click on the Open – View Picture button. The image should open in the default picture 

application as setup on your computer. 

Vehicle Information 
If the selected asset is considered a vehicle, you may want to record vehicle specific information in this 

section. 

To access the Vehicle Information: 

• Move to the Options tab of the assets database, and then click on the Picture - Vehicle tab near 

the bottom. 

The following illustrates the elements found in this section: 
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• Vehicle Year - This field accept up to 4 alpha/numeric characters. 

• State License - This field accept up to 20 alpha/numeric characters. 

• Vehicle License (#) - This field accept up to 20 alpha/numeric characters. 

• Renewal Date - This field accept up to 8 alpha/numeric characters. 

• Plate No - This field accept up to 20 alpha/numeric characters. 

• Vehicle Notes – There is no size limitation on the field. 

Purchase Information 
In this section you can maintain information on the purchase of the selected asset. 

To access the Purchase Information: 

• Move to the Options tab of the assets database, and then click on the Purchase - Appraisal tab 

near the bottom. 

The following illustrates the elements found in this section: 

 

• Purchase Type - Select either New or Used from the drop down list 

• Purchase Date - You can set this value using the attached drop down calendar. 

• Purchase Cost – You can assign this value using the attached calculator, and this would indicate 

the price paid in the asset’s purchase. 
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• Select Vendor – Clicking this button invokes the Vendors Lookup Dialog when you can select 

and assign a vendor. 

• Vendor/Payee – This field can accept up to 40 alpha/numeric characters and would indicate 

who the asset was purchased from. 

• Purchase Order No - This field can accept up to 30 alpha/numeric characters and would indicate 

the purchase order that was used in the asset’s purchase. 

Appraisal Information 
You can calculate an asset’s depreciation using either the double-declining balance method or the 

straight-line depreciation method. 

When using this option you will need the following information available: 

• The initial cost of the asset. 

• The asset’s useful life in months. 

• The salvage value of the asset at the end of its life. 

• The current year in the depreciation calculation. 

To access the Appraisal Information: 

• Move to the Options tab of the assets database, and then click on the Purchase - Appraisal tab 

near the bottom. 

The following illustrates the elements found in this section: 

 

Appraisal Initial Setup 
Before attempting to run the appraisal routine, the following information should be entered into the 

application: 

• Original Value – You can set this value using the attached calculator. This value would indicate 

the purchase cost associated with the current asset. 

• Salvage Value - You can set this value using the attached calculator. This value would indicate 

the amount you think you can sell the asset for, once deposed.  
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• Life Time – You can set this value using the attached calculator. This value would indicate how 

long you expect the asset to be in use. 

Performing the Appraisal 
Once the Initial setup is completed, use the following to perform the actual appraisal: 

• Move to and click on the Calculate Value button. 

 

• There are two accounting methods available. To use the default ‘double-declining’ method click 

on the Yes button to the prompt. To use the ‘straight-line’ method, click on the No button. 

• When prompted about the asset’s initial costs, confirm or edit the value shown and click OK. 

• When prompted about the asset’s salvage value, confirm or edit the value shown and click OK. 

• When prompted about the asset’s useful life in Years, confirm or edit the value shown and click 

OK. 

 

• When prompted about the Asset Year, confirm or edit the value shown and click OK. 

• The program will now perform the calculation and put the resulting value in the Appraised 

Value field. 

• Move to the Appraisal Date field and edit this value to show the date of the appraisal. 
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Property Assignment 
You can assign all your equipment and assets to different properties and locations. When you assign an 

asset as the Primary Asset of a work order, the property assignment automatically follows that asset 

assignment. 

The following image illustrates this assignment: 

 

To make a Property Assignment: 

• Move to the Options tab of the assets database, and then click on the Property Assignments tab 

near the bottom. 

• Click on the Select Property button. 

• From the invoked Properties and Locations dialog move to the grid and select the property you 

want to assign. 

• Click on the Select button. 

Properties Database 
You can build a database of Properties within this module. These properties can then be assigned to an 

asset, which in turn adds the assignments for use with work orders.  

Access the Properties Database 
To access the Properties Database: 

• From the Equipment and Assets module, click on the File menu. 

• Select the Properties Database option. 

Adding a new Property 
To add a new property to the database: 

• Move to the data control and click on the Append (+) button. 
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• Move to the Details tab and begin entering the appropriate information. The following fields are 

supported: 

o Property Description – This is an identifying description of the property. This field will 

accept up to 50 alpha/numeric characters. 

o Primary Contact – This is the name of the property’s main contact. This field will accept 

up to 30 alpha/numeric characters. 

o Contact Title – This field indicates the contact’s job or formal title. This field will accept 

up to 30 alpha/numeric characters. 

o Phone Number – This would be the contact’s telephone number. This field will accept 

up to 30 alpha/numeric characters. 

o Extension – This is the extension for the above phone number. This field will accept up 

to 5 alpha/numeric characters. 

o E-Mail – This is the contact’s email address. There is no limit to the size of this field. 

o Address 1 – This would indicate the property’s address. This field will accept up to 30 

alpha/numeric characters. 
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o Address 2 – This would indicate the property’s address. This field will accept up to 30 

alpha/numeric characters. 

o City – This would indicate the city in which the property is located. This field will accept 

up to 30 alpha/numeric characters. 

o State - Region – This would indicate the state in which the property is located. This field 

will accept up to 30 alpha/numeric characters. 

o Postal Code – This would indicate the property’s postal code. This field will accept up to 

15 alpha/numeric characters. 

o Country - This would indicate the country in which the property is located. This field will 

accept up to 30 alpha/numeric characters. 

• Move to the Notes - Directions tab and begin entering the appropriate information. The 

following fields are supported: 

o Directions – This would show the directions to the selected property. There is no limit to 

the size of this field. 

o Notes - This field is for recording any notes you want to include for the selected 

property. This is no limit to size of this field. 

• Click on the Post (check) button to save your changes. 

Deleting a Property 
To delete a property from the database: 

• Move to the Lookup tab of the Properties Database. 

• Move to the grid here and select the record you want to remove by clicking on it. 

• Click on the Delete (-) button in the data control. 

• When prompted about the deletion, click the Yes button. 

History Log Tab 
This tab holds the History Log database which allows you to maintain a complete history on your current 

asset. Use this log to record such items as completed PMs, repairs made, and other important 

information. Entries to this log can come from work orders, issues and can also be made manually. For 

entries from other modules, please refer to chapter covering those modules for details. 

The following illustrates the elements found in this section: 
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Creating a Manual Log Entry 
To manually create a new log entry: 

• Select and make current the asset you want the entry to apply to. 

• Move to the History Log tab, and locate the data control found there. 

• Click on the Append (+) button in the data control. 

 

• From the invoked New Entry dialog, move to the space provided and enter the information 

there. This field can contain up to 200 alpha/numeric characters. 

• Click on the OK button. 

• Click on the Date field in the grid showing the new entry. 

• Click on the down arrow there to reset the applied date from the attached calendar. 

• Move to the Details text box and edit your entry’s details. You also click on the Edit Details 

button to edit the details with our built in text editor. There is not size limitation applied to this 

entry. 

• Click on the Post (checkmark) button in the data control to save your changes. 

 Deleting a Log Entry 
• Select and make current the asset you want the delete entry from. 
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• Move to the History Log tab, and locate and select the record you want to delete from within 

the grid. 

• Move to the data control and click on the Delete (-) button. 

 

• When prompted about the deletion, click the Yes button. 

Add a New Asset Record 
To add a new asset record: 

• Move to the Home tab in the ribbon and click on the Add New option. 

• Move through the various tabs and edit the new record. 

Save Changes 
To save changes to the main record, click on the Post (✓ check) button in the Data Control located 

within the ribbon’s Quick Access toolbar. 

To save changes to the main record and all the underlying records (links, attachments, etc.), click on the 

Save Changes button found on the Home tab of the ribbon control. 

Asset Print Options 
To print the current asset: 

• Locate and select the asset you want to print. 

• Open the File menu and expand the Asset Print Options menu by clicking on it. 

• Click on the Print Option of your choice: 

o Print Record - Allows printer selection and other options before printing. 

o Quick Print - Sends the document directly to the default printer 

o Print Preview - Provides a print preview of the current document 

Sub-Assembly Print Options 
To print the selected sub-assembly: 

• Locate and select the sub-assembly you want to print. 

• Open the File menu and expand the Sub Assembly Print Options menu by clicking on it. 

• Click on the Print Option of your choice: 

o Print Record - Allows printer selection and other options before printing. 

o Quick Print - Sends the document directly to the default printer 

o Print Preview - Provides a print preview of the current document 
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Printing a Meters Collection Sheet 
You can print a Meters Collection Sheet to help in the process of recording meter readings. In order for 

an asset to show up on this list, the Use Meters checkbox must be checked as found on the Details tab. 

 

To print the Meters Collection sheet: 

• Move to the Home tab in the ribbon and click on the Collection Sheet option. 

Entering Meter Values 
If you have the Use Meter checkbox checked on the Details view of an asset, then that asset will show 

up in a Meters Collection screen. This quick entry screen will allow you to enter updated meter readings 

in one easy to use dialog. This saves you from having to browse through all the records in the database 

to enter this information. 

The following illustration shows the Meters Collection screen: 
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To enter Assets Meters: 

• Move to the Home tab in the ribbon and click on the Enter Meters option. 

• Move to the grid and select the record to edit the value on. 

• Double mouse click within the Meter Value column from within the grid. This invokes the 

column’s edit mode. 

• Edit the value here and click enter. 

• Repeat the editing process for each meter you want to update. 

• Click on the Accept button to both close this screen and save any changes made. 

Asset’s Notes 
You can keep detailed notes on each asset and sub-assemble in the database. These notes use our built 

in word processor that is used throughout the system. To find how to use the features of this word 

processor please refer to the Word Processor chapter. 

To access the Notes option: 

• The Notes option is available to both assets and sub-assemblies. So the first step would be to 

select the appropriate record. 

• With the record selected, move to the Home tab in the ribbon. 

• Click on the Asset’s Notes option to expand the drop down and then select the appropriate 

option available. 

o Primary Asset Notes 

o Sub-Assembly Notes 

Assigned Work Orders 
When the current asset is assigned as the Primary Asset of work orders, you can view work orders that 

are assigned to them. From the displayed work orders, these work orders can also be printed. 

The following illustration shows the Assigned Work Orders screen: 
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To view Assigned Work Orders 
• Select the asset you want to view work orders from. 

• Move to the Home tab in the ribbon and click on the Assigned Work Orders option. 

To Re-Filter the Work Orders 
• Move to the Filter By drop down and select All Open, Completed or View All. 

To see a Print Preview of a selected Work Order 
• Move to the grid and select the work order you want to see a print preview on. 

• Click on the Print Preview button. 

Copy Asset Record 
You can make a copy of the primary fields of a record, to be pasted into a different record. To make a 

copy of a record: 

• Select the record that you want to copy. 

• Move to the Home tab in the ribbon and click on the Copy Asset Record option. 

Paste Record 
To paste an asset record over an existing record: 
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• Copy the record as previously outlined. 

• Select or create the record to paste into. 

• Move to the Home tab in the ribbon and click on the Paste Record option. 

Search 
To perform a search on the Equipment and Assets database: 

• Move to the Home tab in the ribbon. 

• Click on the Search option.  

• Refer to the Search section of the Common Features chapter for more information. 

Main Report – Filter Wizard 
This Wizard is used for both the Filter Wizard and Main Report Wizard of the Equipment and Assets 

module. When used for either filtering or reporting purposes, the resulting items will be returned by the 

choices or criteria as setup with this wizard. 

The following are some of the general elements of this wizard: 

• Previous – This button move you backwards through the tabs. 

• Next – This button move you forward through the tabs. 

• Accept – Accepts the criteria as setup, and closes the wizard. 

• Cancel – Backs out of the operation and closes the wizard. 

Location Tab 
The following illustrates the elements found on this tab: 
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• Location – This criteria specifies the physical location of the asset. Use All returns all locations. 

• Building - This criteria specifies the building the asset is stored in. Use All returns all buildings. 

Assignments Tab 
The following illustrates the elements found on this tab: 

 

• Account – This criteria specifies the account to use. Use All ignores this criteria. 

• Classification – This criteria specifies the Classification to use. Use All ignores this criteria. 

Resources Tab 
The following illustrates the elements found on this tab: 
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• Assigned To – This criteria specifies the Employee Assignment to use. Use All ignores this 

criteria. 

• Manufacturer – This criteria specifies the Manufacturer to use. Use All ignores this criteria. 

Sort by Tab 
The following illustrates the elements found on this tab: 

 

• Sort By – This selection specifies the field to sort by. 

• Asset Status – This criteria specifies the status setting to use. 
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Filtering Options 
On the Filtering tab of the ribbon control, you’ll find the following filtering options: 

• Default Filter – Filters the database to show all records. 

• Filter Wizard – Use the criteria of the Main Report – Filter Wizard to filter the database by. 

• Uses Meters – This filters the database by all records that have the Use Meters value checked. 

• Selected Records - This filters the database by all records that have the Selected value checked. 

Work Orders Report Wizard 
The Work Orders Report wizard is used in the creation of the Assigned Work Orders report and the 

Predictive Maintenance Report. 

The following illustrates this wizard: 

 

• Work Order Types – Make this selection by clicking on one of the available options here. 

o Planned Maintenance – Reports on recurring work order types. 

o Repair Work Orders – Reports on one-time work order types. 

o All Types – Reports on all available work types. 

• Work Order Status – When available, returns only those record with the selected status. 

o Completed – Returns records with a status of completed. 

o Open – Returns all records that have not been marked as completed. 

o View All – Ignores the work order status indicators. 

• Date Range – Returns work orders that fall within the provided date range. 
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o Start Date – This is the scheduled start date of the provided date range. 

o End Date – This is the scheduled end date of the provided date range. 

o Use All Dates – Ignores dates and returns all. 

• Accept – Accepts and applies the criteria as setup. 

Date Selection Dialog 
Some of the available reports are based on a date range. The following illustrates the Dates Selection 

Dialog: 

 

• Start Date – This is the start date of the provided date range. 

• End Date – This is the end date of the provided date range. 

• Use All Dates – Ignores dates and returns all. 

Report Wizard Report (Asset Report) 
This report uses the Main Report – Filter Wizard for the creation of this report, and the records 

returned by the report. This is basically an Assets List report. 

 

To create the Main Asset Reports: 

• Move to and click on the Reports tab in the ribbon. 

• Click on the Report Wizard option. 

• Follow the instructions as outlined in the Main Report – Filter Wizard section. 

Assigned Work Orders Report 
This reports uses the Work Orders Report Wizard in the creation of the report and is based on the 

currently selected asset only. This report returns a basic list of assigned work orders. 
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To create the Assigned Work Orders Report: 

• Select and make current the asset record you want create the report on. 

• Move to and click in the Reports tab in the ribbon. 

• Click on the Assigned Work Orders option. 

• Follow the instructions as outlined in the Work Orders Report Wizard section.  

History Log Report 
To print a copy of the History Log: 

 

• Select and make current the asset record you want create the report on. 

• Move to and click in the Reports tab in the ribbon. 

• Click on the History Log option. 

• Follow the instructions as outlined in the Date Selection Dialog section.  

Property Information Report 
To print information of the assigned property: 
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• Select and make current the asset record you want create the report on. 

• Move to and click on the Reports tab in the ribbon. 

• Click on the Property Info option. 

Predictive Maintenance Report 
This report will report on the dates between a part's repeated replacements. It calculates both the days 

and months between these replacements. With this information the user can predict when a part may 

fail again. 

To create a Predictive Maintenance Report: 

 

• Select and make current the asset record you want create the report on. 

• Move to and click on the Reports tab in the ribbon. 

• Click on the Predictive Maintenance option. 

• Follow the instructions as outlined in the Work Orders Report Wizard section.  
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Mechanics and Employees Database 

The information from the Mechanics and Employees Database is used throughout the system as it 

relates to the entry fields that require an employee assignment. 

 

Ribbon Control 
The basic functionality of the Mechanics and Employees module is provided via a set of Ribbon tabbed 

pages. Ribbon pages are structurally and visually split into logical groups. Each of these groups includes 

commands that perform specific functions. 

EMPLOYEES TAB 

 

The following are the elements on the Home ribbon tab, reading left to right: 

• Add New – Creates a new blank record in the database. 

• Save Changes – Saves all current changes from all elements of a record (master save). 

• Individual Notes – Allows the viewing and editing of the notes assigned to the current record. 

• Preview – Provides a Print Preview of the selected record. 
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• Telephone List – Create a telephone list report. 

• Search - Invokes the search/find routine on the Lookup Grid. 

• Exit Module - Close and exits the module. 

FILTERS TAB 

 

The following are the elements on the Filters ribbon tab, reading left to right: 

• Default Filter – Shows every record in the database. 

• Active Employees – Shows every record in the database that has not been marked as Inactive. 

• Inactive Employees – Shows every record in the database that has been marked as inactive. 

Employee Details 
This section allows you to specify general information about the current associate. This information is 

found in the General Information group, location within the Details tab.  

The following illustrates the elements found in this section: 

 

Full Name 
This alpha/numeric field will accept up to 40 characters and represents the employee’s full name. For 

lookup purposes it is recommended that you use the format: last name, first name. 

E-Mail 
This alpha/numeric field has no size limitations and represents the associate’s email address. 

Job Title 
This alpha/numeric field will accept up to 30 characters and represents the associate’s assigned job. 

Shift/Crew 
This alpha/numeric field will accept up to 30 characters and represents the associate’s assigned shift or 

crew 
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Reference ID 
This field should be unique in your database, but it’s not an enforced rule. It is used to help identify your 

associate. Edit this field by typing in the space provided. This field can accept up to 30 alpha/numeric 

characters. 

Once the Full Name field has been entered you can click on the Auto Reference button to have the 

application create the Reference field for you. 

To insure the Reference is unique in the database, click on the Check Reference button. 

Telephone Numbers 
The information stored in this area represents the phone numbers related with the selected associate. 

Each of these alpha/numeric fields can contain up to 15 characters each with the exception of the 

Extension field. The Extension field is limited to 5 characters. 

The following illustrates the elements found in this section: 

Hourly Rate 
This floating point field is used to record an associate’s hourly pay rate. This information is used with 

work order labor calculations. 

Emergency Contact Information 
This section allows you to record contact information to be used in the case of an emergency. 

Emergency Contact Name 
This alpha/numeric field can contain up to 40 characters and is used to record the name of the 

associate’s emergency contact. 

Emergency Contact Telephone Number 
This alpha/numeric field can contain up to 15 characters and is used to record the telephone number to 

use when contacting the emergency contact. 

Add a Record 
To add a new employee record: 

• Move to the Home tab in the ribbon and click on the Add New option. 

• Move through the various tabs and edit the new record. 

Save Changes 
To save changes to the main record, click on the Post (✓ check) button in the Data Control located 

within the ribbon’s Quick Access toolbar. 
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To save changes to the main record and all the underlying records (links, attachments, etc.), click on the 

Save Changes button found on the Home tab of the ribbon control. 

Individual Notes 
You can keep detailed notes on each associate record in the database. These notes use our built in word 

processor that is used throughout the system. To find how to use the features of this word processor 

please refer to the Word Processor chapter. 

To access the Individual Notes option: 

• With the record selected, move to the Employees tab in the ribbon. 

• Click on the Employee Notes button. 

Telephone List Report 
This report provides a Telephone List including all employees. 

 

To create the Telephone List Report: 

• Move to the Employees tab in the ribbon and click on the Telephone List option. 

 

 


